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INTRODUCTION 
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1 Customer information 

1.1 Carlson Software 

Congratulations on purchasing a Boretrak2 hole deviation surveying system from Carlson Software.  
 
Founded in 1983, Carlson Software specializes in CAD design software, surveying hardware, and machine control 
products for the land surveying, civil engineering, construction, and mining industries worldwide, providing one-
source technology solutions from data collection to design to construction.  
 
The Boretrak2 is designed and built with Carlson’s world-class levels of detail, quality and innovation.  
 
Carlson’s renowned dedication to customer service is unique in the industry. 
 
For any technical support issues related to your Boretrak2 system contact us directly or, alternatively, contact your 
local Carlson-approved service and support centre. Details of all contacts are on our website:  www.carlsonsw.com. 
 
To ensure the best service when contacting Carlson about your Boretrak2, please make a note of the serial number. 
This can be found on the instrument (see Figure 33). 

1.2 User manual 

The Boretrak2 system is designed to be easy to operate. However, please take the time to read these operating 
instructions carefully before using the system and always them with the instrument. 
 
This manual is divided into three main parts: 

• Boretrak2 hardware: a description of all elements of a Boretrak2 system and associated accessories. 

• Field operational guide: a quick guide to show a typical use of the Boretrak2 and software in the field. 

• Carlson Boretrak software: a detailed description of all functionality and controls in the accompanying 
Carlson Boretrak software. 

Carlson Boretrak software is integral to the operation of the Boretrak2. There are two versions of this software: 
one runs on Windows tablets and PCs, the other runs on Android-based mobile devices. The software is described 
in detail from section 10 onwards. 
 
This manual is also available via the About screen in both versions of Carlson Boretrak. 
 
This document has been compiled with care. However, should you discover any errors, we would be grateful if you 
could contact Carlson directly. 
 
Reproduction of this document in whole or in part, including utilisation in machines capable of reproduction or 
retrieval, without the express written permission of Carlson is prohibited. Reverse engineering is also prohibited. 
 
The information in this manual is subject to change without notice. 
 
For any feedback or comments, or if there are questions about the Boretrak2 which are beyond the scope of this 
manual, contact Carlson Software. 

1.3 Notes on probes running version 1.0 firmware 

The first generation of Boretrak2 probes run firmware version 1.0.  
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Subsequent generations of probes with later versions of firmware feature an enhanced alignment routine with a 
more robust solution generated throughout each deployment. They also feature improved power management and 
the ability to upgrade to future firmware versions remotely, via Bluetooth. 
 
On connection with Carlson Boretrak software, if your probe is identified as running version 1.0 firmware, a 
message appears. 
 

 
 
Carlson recommends that users with first generation probes upgrade to the most recent version of firmware.  
 
This upgrade is carried out at a Carlson-approved service centre. Contact Carlson for further details. 
 
 
 
 



 

BT2 user manual - H-5911-9004-03-A   P a g e  | 7 

2 Boretrak2 system concepts 

2.1 System overview 

The Boretrak2 system is a portable, simple-to-use, borehole deviation measurement system which is valuable in 
many applications such as underground mining, open pit mining, quarrying, and in a variety of civil engineering 
applications.  
 
The Boretrak2 probe is designed to survey the route of drilled boreholes by measuring their inclination and heading 
at fixed intervals along the hole. 
 
The Boretrak2 is based on previous iterations of the Cabled and Rodded Boretrak products. The features of both 
old units are combined into a single all-purpose system, capable (Advanced model only) of measuring boreholes in 
any inclination: down, up or horizontal. 
 
The Boretrak2 utilises a miniature inertial measurement unit (IMU) which contains a triaxial accelerometer, 
magnetometer, and gyro. Prior to deployment, the probe is aligned against a known orientation on a supplied jig. 
This establishes a starting, reference heading for the gyro. The IMU provides the Boretrak2 with an accurate heading 
and inclination.  
 
The Boretrak2 probe is attached to a cable or push rods and deployed along a borehole. The system is deployed 
at a series of fixed intervals, most commonly 2 m. IMU data is recorded at each interval as the probe is deployed 
along the borehole. 
 
In this way, the Boretrak2 builds up a 3D map of the borehole. 
 
The Boretrak2 is not reliant on magnetic sensors and is therefore ideally suited for measuring boreholes where 
there may be material present which would influence a compass. 
 
The Boretrak2 system can be rapidly deployed on site, at any inclination, and requires no specialised tools or 
equipment other than those supplied with the system. 

2.2 Basic and Advanced models 

The Boretrak2 is available in two models: Basic and Advanced. The two models are differentiated by the range of 
inclinations over which they can operate. 
 
The Basic model operates over a range of +/-60° from vertically down. This model is primarily designed for 
applications such as quarrying and open pit mining where all holes are inclined downwards. Usually, Basic units 
are deployed exclusively on the supplied steel cable. 
 
The Advanced model operates at all inclinations. This model is designed for underground mining applications where 
holes are drilled in all directions: downwards, horizontally, and upwards. The Advanced unit can also be deployed 
with the steel cable when being used downhole. However, for horizontal and uphole operations, the push rod system 
or Boretrak rods must be used.  
 
Your Boretrak2 probe will have been set as a Basic or Advanced unit in the factory. If your probe is set as a Basic 
unit, you can purchase an upgrade to convert it into an Advanced unit. Contact Carlson for details. 

2.3 Data communication and storage 

During a Boretrak survey, the operator configures and controls the Boretrak2 project via Carlson Boretrak software 
which runs on a tablet or mobile device.  
 
The Boretrak2 and the tablet running Carlson Boretrak communicate via a Bluetooth link. However, during a 
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deployment, this link will usually be disconnected. Therefore, before deployment, the date and time in the probe are 
synchronised with the date and time in the tablet. From this point, the probe starts recording IMU data into its internal 
memory. Readings are taken every second and the probe’s LEDs visually indicate that this process is ongoing. 
Each sensor record in the probe is accompanied by a time stamp. 
 
At each deployment interval, with the system held steady, the operator on the surface records a time stamp using 
Carlson Boretrak. 
 
Once a survey has been completed, and the Boretrak2 is back on the surface, the Bluetooth link is re-established 
and all IMU data from the probe is automatically downloaded to Carlson Boretrak. 
 
Carlson Boretrak reads the time stamps recorded on the tablet and extracts the records in the probe data which 
have matching time stamps. 
 
With reference to a starting hole collar coordinate and an initial alignment heading, these raw observations are 
converted into a sequence of X, Y, Z coordinates. A model of the hole is then created, and a comparison can be 
made to a design hole or another survey of the same hole. 

2.4 Carlson Boretrak software 

Carlson Boretrak software acts as the survey controller which enables you to set up projects, manage holes, 
conduct the survey, and view results. 
 
Versions of Carlson Boretrak are available to run on a Windows tablet or an Android mobile device.  
 
Carlson Boretrak displays real-time data from the probe while the Bluetooth connection is live. During a 
deployment, the probe is in a borehole, so the connection is usually disconnected. The connection is automatically 
re-established when a hole survey is complete, and the probe has been retrieved to within Bluetooth range of the 
tablet. 
 
After downloading data, a visual inspection of the hole survey is possible. You can compare the surveyed hole with 
design data and export the project for use in other software packages from Carlson or in third party packages.  
 
Carlson Boretrak allows you to manage the geo-referencing of the holes, and to send final data directly from the 
field. 
 
Back in the office Carlson Boretrak can run in Desktop mode on an office PC. This allows a more comprehensive 
data analysis to be conducted, and reports and exports can be generated. 
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OPERATIONAL GUIDE 
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3 Boretrak2 deployments – gyro introduction 

The Boretrak2 is fitted with an Inertial Measurement Unit (IMU) which incorporates a 3-axis MEMS-based gyro and 
a 3-axis accelerometer. 
 
The IMU integrates information from both the gyro and the accelerometer, and the output orientation is determined 
by fusing the outputs of both these sensors through a software-based Kalman filter model. 
 
The advanced IMU solution ensures that the attitude and orientation of the Boretrak2 probe can always be tracked 
as it is deployed along a borehole, whether it is pointing up, down or horizontal. 

3.1 Gyro drift 

The results from a gyro may drift with time. If you lay a gyro flat and absolutely still, it will output a heading. If you 
leave the gyro in exactly the same position, the raw heading that it outputs will gradually change, even though the 
gyro is not changing position or rotating. This is ‘drift’ and it is effectively an error that will affect raw data output 
from a gyro. 
 
The results from a gyro may also drift with temperature, with severe temperature changes causing greater drift in 
the gyro output. 
 
Processing in the Boretrak2 firmware and Carlson Boretrak software helps to mitigate these effects on the gyro in 
the installed IMU. The raw gyro drift over a given time is kept to a minimum and constant checks on the drift 
throughout the deployment ensure that temperature changes are mostly accounted for. If the accelerometers detect 
that the Boretrak2 is held static at any point, then the gyro is effectively locked so that any drift during this period is 
ignored. 
 
However, from the moment the Boretrak2 is first aligned, the accuracy of the gyro is slowly deteriorating due to an 
accumulating angular error. This means that the deployment operation should be as prompt and efficient as 
possible.  
 
In ideal circumstances, during operations, the drift of the gyro will be <1.0° per 30 minutes.  
 
Each time the Boretrak2 is aligned in a known orientation, any error is reset to zero. Therefore, it is worthwhile 
realigning the probe as often as is practically possible during field operations. 

3.2 Gyro alignment 

The gyro in the Boretrak2 does not output a heading with respect to true north. The gyro can measure the angle 
that it is rotated through as it is deployed or as it is moved around on the surface, but it cannot determine which 
direction it is pointing in when it is switched on. 
 
For this reason, we must manually define the starting, ‘reference’ heading of the probe at the beginning of an 
operation. Once we have determined this starting orientation, the gyro can then keep track of the changing heading 
as it is moved around and deployed. 
 
After the Boretrak2 is powered ON, and before it is deployed, the unit must undergo an alignment which is when 
this starting heading is established.  
 
During the alignment the probe should be located within the operations area, ready for the deployment to 
commence. The probe should be laid out horizontally (roughly +/- 20° from horizontal) on a solid, stable surface. An 
alignment jig is supplied to provide an easy mounting point for the probe. 
 
The alignment lasts approximately 3 seconds. During this period, the Boretrak2 probe must be motionless. Site the 
probe away from areas where knocks or excessive vibration may occur. If movement is detected, the alignment 
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may automatically restart multiple times before it is successfully completed. 
 
If it is suspected that the probe has moved during the alignment, or that the readings from the probe seem to be 
unstable immediately after the alignment, then it is essential to realign the probe. 
 
For the purposes of a Boretrak2 survey, the reference heading is defined by the orientation of the probe, pointing 
in the direction of the nose cone, while it is held static in the alignment jig.  
 
Using traditional survey techniques, establish this heading with respect to your site coordinate system while the 
probe is held static in the alignment jig.  
 
The surveyed, starting heading is entered into Carlson Boretrak software in the Alignment window (see section 
15.5). 
 
If the jig is held securely in place, multiple, repeatable alignments can be taken from the same position between 
Boretrak2 deployments down different boreholes. Also, if required, the jig can be left in place for a surveyor to 
observe with their total station after the deployment has been completed. The jig heading can then be entered into 
Carlson Boretrak retrospectively (see section 14.1.4). 
 
Note that other customised hardware devices which perform the same function as the alignment jig may be used if 
they are more suitable for your specific operations. 

3.3 Gyro limits 

The gyro is limited to measuring rates of rotation of up to 960°/sec in each axis. In practice this should not be a 
limiting factor providing no sudden rotational accelerations are encountered or constant rotations of greater than 
~1.1Hz are not encountered.  
 
If the gyro does rotate beyond its current limit, in any axis, an out-of-range error will be displayed. In this case you 
must retrieve and realign the probe before starting the deployment again. 
 

 
Note that this error can only be registered by Carlson Boretrak while the Boretrak2 probe and tablet have a live 
Bluetooth communications link established. If the rotation limit is exceeded while the probe is out of Bluetooth range 
of the tablet, then the message appears as soon as the Bluetooth connection is restored.  
 
Any data collected since the alignment was lost will be unreliable. Therefore, whenever this message appears, you 
should realign the probe and repeat the survey of the hole(s) surveyed since the alignment was lost. 
 
To avoid exceeding this rotational speed limit, once the Boretrak2 is aligned, handle the probe carefully and steadily 
as it is being moved into the hole. During the deployment, lower the probe carefully and steadily. If you deploy the 
probe on the steel cable alone, try to ensure as little rotation as possible is introduced through twist in the cable. 

Figure 1 Gyro exceeded rotational speed limit 
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3.4 Gyro check 

After the probe is retrieved from the hole it is possible to perform a gyro check to confirm that the dynamics, shocks 
and rotations experienced during the deployment have not caused the gyro to drift or lose accuracy. 
 
As long as the Broretrak2 is still aligned, place the probe back on the alignment jig and select Align > Verify 
Alignment.  An error factor is displayed to give an indication of the change in angle during the survey. See section 
15.2.6. 
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4 Boretrak2 deployments – geo-referencing 

4.1 Georeferencing a survey 

When using the Boretrak2 system, it is usually the case that the absolute position and orientation of the surveyed 
hole will be required. For example, if deviation is detected in the borehole, in which direction is it inclined and how 
does this relate to other features above or below the ground? 
 
To establish the position and orientation of the surveyed data, two values are required: 

1. The position of the borehole collar. 

2. The orientation of the probe during the gyro alignment. 

With these two values established, when the Boretrak2 probe is deployed down the borehole, all subsequent 
readings can be related back to the starting position and orientation. The surveyed hole can also be referenced to 
any other features surveyed on the same coordinate system: for example, a quarry face or an underground tunnel. 

4.2 Position of the borehole 

The position of the borehole can be established by: 

• GNSS. 

• Traditional survey methods. 

• A Carlson Quarryman Pro. The Quarryman Pro is used in quarrying operations to scan a quarry face and 
to position borehole collars. 

If the collar is very wide and uneven, take care to survey to the exact point from which the deployment is to be 
measured. 

4.3 Orientation and positioning of the alignment jig 

Find a location for the alignment jig. The location must be close enough to the collar so that the Boretrak2 can be 
promptly deployed when the alignment is complete. 
 
The location should be solid and not subject to movement or vibrations. Ensure the jig is roughly horizontal (ie. 
within 20° of level). 
 
It is important to minimise handling of the Boretrak2 probe between the alignment and deployment. Therefore, if 
convenient, keep the deployment device attached to the probe while it is being aligned. This may influence where 
you choose to position the alignment jig, particularly if using the push rod system for deployments. 
 
The heading of the Boretrak2 in the jig must be entered into Carlson Boretrak. The heading is that which is defined 
by the direction of the Boretrak2 from the rod adaptor to the tip of the nose cone (see Figure 2).  
 
This heading can be established by: 

• A direct survey of the jig using traditional survey methods. 

• Aligning the jig along a line of known azimuth – eg. along the centre of a tunnel underground, or along a 
shotline in a quarry. 

• Aligning the jig between two points with known coordinates – eg. between two surveyed hole collars. The 
heading between the two holes can be computed in Carlson Boretrak software. 
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• A good-quality, hand-held compass. This is the least accurate option. Stand behind the alignment jig and 
take a compass bearing looking along the jig in the direction that the probe is, or will be, pointing. If using a 
magnetic compass, ensure that the immediate area is free from external magnetic influences, such as drill 
rigs or mobile phones.  

Note that if a compass is used, the measured bearing will be relative to magnetic north. The relationship 
between the magnetic bearing from the compass and any local grid north that is used for other survey data 
will need to be established if data from the Boretrak2 is to be used in conjunction with data from other 
systems such as GPS or the Quarryman Pro. 

Note that the heading of the alignment jig is independent from the direction of the hole being surveyed. The 
measured heading provides a starting reference for the survey. Once the gyro is aligned in this heading, the gyro 
tracks any subsequent changes of orientation.  
 
Establishing the reference heading of the jig can take place at any time before or after the deployment. As long as 
the alignment jig is not moved between aligning the gyro and surveying the heading, you can establish the reference 
heading when the Boretrak2 survey is not in progress. 
 

 
Figure 2 Surveyed heading of the alignment jig 
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5 Boretrak2 deployments – a typical project in the field 

The procedure outlined below is a ‘quick start guide’ to using a Boretrak2 in the field.  
 
The methodology is based around a borehole survey on a quarry. The project includes importing design holes into 
the Carlson Boretrak project. The alignment jig is orientated during the survey by physically aligning it between 
pre-surveyed holes. The project is run on a Windows tablet.  

5.1 Preparing for the survey 

Before carrying out a survey, check: 

• You are running the most recent release of Carlson Boretrak, available from Carlson’s website. 

• The Bluetooth function on your tablet is turned ON and the Boretrak2 probe is paired with your tablet. 

• The supplied, rechargeable Boretrak2 batteries are fully charged. 

• The probe, thread, batteries and deployment device are all inspected and found to be in good condition and 
free from damage. 

Load the batteries into the Boretrak2 nose cone and screw the nose cone securely onto the probe. The 
Boretrak2 is now ON.  
 
The probe LEDs start by showing solid yellow while the power is stabilising. They progress to flashing blue if 
there has been no Bluetooth connection, or flashing red if there has been a Bluetooth connection. 

5.2 Setting up Carlson Boretrak 

5.2.1 New project 

Open Carlson Boretrak software. Tap New to start a new project. 
 

Figure 3 Touch mode Home screen 
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The Project window opens. 
 
Enter a Project Name. Enter the Surveyor and any Notes as required.  
 

5.2.2 Import design holes 

To import holes into the project, select the Holes tab, then tap Import.  
 

 
The Browse window appears. Navigate to find the file containing the design holes. These may be in the form of a 
standard ASCII text file such a *.TXT or *.CSV file, or else a Carlson *.DRL file. 
 

Figure 4 New project window 

Figure 5 Project window > Holes tab 



 

BT2 user manual - H-5911-9004-03-A   P a g e  | 17 

 
DRL files import directly into Carlson Boretrak. 
 
To import holes from an ASCII text file, the ASCII Import window appears. Pre-defined import formats can be setup 
so that the file is directly imported into Carlson Boretrak. When importing for the first time, manually assign fields 
for the data in the *.CSV file. Tap on the header of a column then select the appropriate field from the Data drop 
down list. 
 

 
  

Figure 6 Import hole file 

Figure 7 ASCII Import window 
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After defining the last column, click Confirm, then Import. 
 

 
The design holes are loaded into the project. They are visible in the 3D View, listed in the Project window Holes 
tab, and also appear in the Project tab. 
 

 
Tap Create to create the new project. 
 
  

Figure 8 ASCII Import window > completing the import 

Figure 9 Project window > Holes tab 



 

BT2 user manual - H-5911-9004-03-A   P a g e  | 19 

5.2.3 Connection 

On creation of a new project, Carlson Boretrak automatically starts searching for a paired Boretrak within 
communication range. 
 

 
When Carlson Boretrak connects to the probe, the Control tab is populated with Boretrak controls. 
 
If no connection is made, check: 

• The Boretrak2 probe is powered ON and flashing red or blue. 

• The Boretrak2 is paired to your tablet. 

• Bluetooth is switched ON on your tablet. 

• No other devices are connected to the same Boretrak2 probe. 

Tap Find Boretraks to reattempt a connection. 

5.3 Alignment 

By default, the survey will start at Hole 1. Position the alignment jig so that it is lined up between Hole 1 and Hole 2 
(see Figure 11). Ensure the jig is on solid ground and reasonably close to level (i.e.: within 20 degrees). 
 
Connect the steel cable securely to the Boretrak2 probe using the deployment adaptor (see section 6.6).  
 
Position your probe in the supplied jig. The probe can be rolled around its axis in any rotation, but the nosecone 
must point towards Hole 2. 

Figure 10 Connecting to a Boretrak2 
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Hole 2 

Hole 1 

Boretrak2 on 
alignment jig 

Heading computed 
from hole 1 to hole 2 

Steel cable attached 
to Boretrak2 probe 

Figure 11 The probe in the alignment jig aligned between two holes 

Figure 12 Probe held in the alignment jig 
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In the Control tab, tap Align Gyro. 
 

 
Note that if the Boretrak2 probe is not stable during the alignment, the alignment may be delayed. In this case, the 
gyro button turns yellow. This may occur if the probe suffers vibrations or shocks during the alignment process.  
 
The alignment will complete when the probe is stable.  
 
The Alignment Details window appears. 
 
In the Azimuth frame, select Relative. From the drop-down lists, select From: 1 and To: 2. The heading from Hole 
1 to Hole 2 is computed and used as the starting alignment heading for the survey. 
 

 
Alternatively, you can just enter a known heading. The required heading is always that pointing along the probe 
towards the nose cone. 
 
To enter a known heading, in the Alignment Details window, select Heading and enter the known heading value. 

Figure 13 Align Gyro button 

Figure 14 Establishing a relative heading between two holes 
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Click Finish to close the Alignment Details window. 
 
After an alignment is complete, handle the probe with care to ensure the gyro can keep track of the changing 
heading and to avoid exceeding the rotation rate threshold of the gyro. 

5.3.1 Probes running version 1.0 firmware 

The first generation of Boretrak2 probes run firmware version 1.0. These probes must be positioned with the 
Boretrak logo pointing upwards when they are being aligned, see Figure 12. The software identifies when a probe 
running version 1.0 firmware is connected. When you initiate an alignment, a message appears prompting you to 
position the probe in this way. 
 
Subsequent versions of firmware do not require the probe to be rolled in any specific way. 

5.4 Deployment 

In the Control tab, the Align Gyro button turns green once the heading has been aligned, and then disappears.  
 
After a successful alignment, an Alignment icon appears in the top of the Control tab. Tap the Alignment icon to 
realign the gyro between holes (see section 15.5). 
 
From this point onwards, the IMU tracks the orientation of the probe in relation to this starting heading. The probe 
logs all IMU data. 
 
While the gyro is aligned, always handle the probe carefully and avoid knocking or sharply twisting the probe. 
 
The icon in the top right of the Control tab flashes green, indicating that the probe LEDs are also flashing green. 
This indicates that the gyro is aligned, and the survey can commence. 
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Check that Hole 1 is selected from the Hole drop down list. Select the correct Segment Length: usually 2 m. 
 

 
The live Heading and Inclination values are displayed.  
 
The Take Reading button is active and the deployment is ready to start. 

Figure 16 Hole and Segment length selected 

Alignment icon LED icon 

Figure 15 The Control tab after an alignment, ready to survey 

Live heading and 
inclination 
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Leave the jig in place. Pick up the Boretrak2 probe ready to deploy into Hole 1.  
 
Tap the Zoom to hole button. The 3D View zooms in on the hole selected for survey. An animated model of the 
Boretrak2 probe is visible at the hole collar.  
 

 

Figure 17 Boretrak2 ready to deploy 

Figure 18 Zoom in on the selected hole in the 3D View 

Take Reading 
button 
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Deploy the Boretrak2 probe 2 m into the borehole. The deployment distance is measured from the nose of the 
probe. 2m will take the probe down the borehole so that the second nodule on the steel cable is level with the hole 
collar.  
 

 
With the second nodule against the hole collar, hold the probe still and tap Take Reading. 
 
In the 3D View, the probe progresses 2 m. In the Control tab, the current length of the hole and the number of 
Segments (readings taken) are displayed. 
 
The Final Reading and Undo Last buttons become active. 
 
The process of collecting Boretrak readings during the deployment is entirely manual.  

o Don’t forget to take a reading at every segment length (in this case, 2 m) 

o Do not take more than one reading at a segment length  

o Only deploy by the selected segment length  

 

First nodule 
on steel cable 

Probe lowered 
until the second 
(2 m) nodule is 
level with the 
hole collar. 

Figure 19 Deploying the probe into the hole 
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If you take a reading by accident, tap Undo Last to go delete the last reading. 
 
Continuing lowering the probe two metres at a time. Stop at each deployment interval, steady the probe and take a 
reading. 

5.5 Bluetooth connection 

When the Boretrak2 probe starts a survey, there is a live Bluetooth link between the probe and the tablet. While the 
live link is retained, data is ‘silently’ downloaded from the probe to the tablet, approximately every thirty seconds.  
 
After the first reading is taken, this link is disconnected. 
 

 
With the link broken, the Reconnect button appears.  
 
Continue with the deployment as before. 
 

Probe deployed 
2 m 

Design hole 

Hole collar 

Current length of 
deployment and 

number of segments 

Figure 20 Deployment in progress 

Figure 21 Bluetooth connection lost 
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In the 3D View all segments added after the Bluetooth link has been disconnected are shown as flashing yellow. 
These yellow segments are provisional and are just based on the last live reading taken. They will be updated 
when the Bluetooth link is reconnected, and data is downloaded from the probe at the end of the survey. 
 

 
In addition, with no live Bluetooth link, the deployment displayed in the Project tab is shown as a warning triangle. 
 

 
All data must be downloaded from the probe before any analysis of the data is carried out, and before any 
reporting or exports are generated. Therefore, before saving and closing the project, ensure that a live Bluetooth 
link is re-established and all data has been downloaded. 

Deployment 
with all data 
downloaded 

Deployment 
with data yet 

to be 
downloaded 

Figure 22 Readings taken while Bluetooth is disconnected 

Figure 23 Project tree showing a warning triangle 
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5.6 Completing a deployment 

When you feel the Boretrak2 probe touch the end of the borehole, keep the steel cable tight so that the probe 
remains upright with respect to the hole. 
 
Tap Final Reading to take the final reading in the borehole. 
 
The Final Offset controls appear. 
 

 
Commonly, when the probe reaches the end of the hole, the last deployment interval does not equal the full, user-
defined Segment Length. In this case, while the probe is at the end of the hole, keep the cable taught and measure 
the distance from the hole collar back along the cable to the next measurement point, i.e. the next interval / nodule 
/ rod joint to which you would deploy if the hole were longer.  

Figure 24 End of hole controls 
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Enter the measured offset into the Final Offset field. This value is deducted from the last reading’s full segment 
length. 

 
In the example in Figure 24 above, 9 * 2 m readings have been taken, giving a total of 18 m. But since the last 
deployment was not fully down to the next nodule, the Final Offset is measured and entered as 0.5 m. Therefore, 
the surveyed hole length is:  
 

18.00 m – 0. 5 m = 17.5 m. 
 

To end the survey, tap Finish.  
 
The Next Deployment controls appear. 
 

 
By default, it is assumed that the next hole to be surveyed will be the next hole in sequence in the list of holes in 

Hole collar 

The next nodule 
that would have 
been used 

Final offset 

Figure 25 Final offset at end of deployment 

Figure 26 Next Deployment controls 
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the project: in this case, hole 2. Tap Deploy to 2 to continue to the next hole.  
 
To continue surveying to a different hole, select the required hole from the drop-down list. 
 
The current hole switches to your selected hole and the Control tab is ready for the next deployment.  

5.7 Bluetooth reconnection 

When you tap Finish to end a deployment, Carlson Boretrak automatically re-establishes the Bluetooth link as 
soon as the probe is detectable by the tablet’s Bluetooth antenna. 
 
With the link restored, the Reconnect button disappears.  
 
All records that have been logged while the Bluetooth link has not been connected are downloaded.  

5.8 Realignment 

For maximum survey accuracy, align the probe as regularly as possible. 
 
During a deployment, the Alignment icon is visible at the top of the Control tab.  
 

 
If the probe is rotated beyond the maximum rotational speed limit, the IMU loses alignment. The Probe LEDs flash 
red, which is reflected in the LED icon in the Control tab, which also turns red. The red Align Gyro button 
appears. Realign the probe and repeat any deployments which were in progress while the alignment was lost. 
 

 
When a deployment is complete, to realign the gyro, tap on the Alignment icon. The Alignment Options dialog 
opens. 

Figure 27 The Alignment icon 

Figure 28 The Alignment icon when gyro alignment has been lost 
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The Boretrak2 probe must be positioned on the alignment jig. The jig may be left in the same position as for the 
previous alignment, if it is still convenient to use it in that location, or it could be repositioned between the next two 
holes. 
 
Tap New to align the probe. Proceed with deployments in subsequent holes. 

5.8.1 Probes running version 1.0 firmware 

The first generation of Boretrak2 probes run firmware version 1.0. If you are using a first-generation probe, it is 
recommended that you use the Verify button to check the current quality of the gyro heading. The software identifies 
when a probe running version 1.0 firmware is connected. When you complete a deployment, a message appears 
prompting you to carry out this check. 
 
Subsequent versions of firmware have an enhanced alignment sequence which is more robust during a deployment. 
Even so, using the Verify feature can help to give confidence in the current status of the gyro if you are surveying 
multiple holes using a single alignment.  
 
The Verify button is found in the Alignment Options window. See section 15.2.6 for further details. 
  

Figure 29 Alignment Options 
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5.9 Data analysis and deliverables 

All hole coordinates and alignment headings can be edited retrospectively. 
 
In the Project tab, click on a hole, then on the Hole Details button to edit hole coordinates and planned hole details. 
 

 
From the Menu tab. Tap Alignments. Tap on the appropriate alignment to edit the heading, which will recompute 
all deployments which used that alignment. 
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To view the details of a deployment, go to the Project tab, tap on a specific Deployment and tap the Deployment 
Details button. 
 

 
The Deployment Details window appears. A table shows details of each reading taken in the selected hole, 
including the deviation from the planned hole at each deployment depth.  
 

 
2D plots show different views of the surveyed hole alongside the planned hole. 
 
From the Menu tab, tap Reports to generate PDF reports of deployments in the project. 
 
The report displays hole information, tabular representation of all readings, a 2D side view and a plan view of the 
hole.  
 
From the Menu tab, tap Exports to export the surveyed and planned data in a choice of formats. Select the data 
format and then pick the specific datasets you wish to export. 

Figure 30 Deployment Details button 

Figure 31 Deployment Details window 
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5.10 Points to remember 

The following points summarise some important points to remember to ensure the optimal accuracy and 
consistency from your Boretrak2 surveys. If you are having problems with your survey results, check that all these 
points have been taken into consideration. 

5.10.1 All deployments 

• Check that you are running the most recent release of Carlson Boretrak, available from Carlson’s website. 

• Make sure all data is downloaded after a survey. In the Project tab there must be no Deployments left 
showing a warning triangle.  

• Handle the probe with care to ensure the gyro can keep track of the changing heading and to avoid 
exceeding the rotation rate threshold of the IMU. 

• The Process of collecting Boretrak readings during the deployment is entirely manual. This will mean you 
will incur a gross error in the length of the hole (and thus in the end coordinates of the hole) if you: 

o Forget to take a reading at a segment interval 

o Take more than one reading at a segment interval 

o Enter the wrong segment interval before the deployment 

o Enter an incorrect Final Offset value. 

5.10.2 Alignments 

• The probe must be absolutely still when you carry out an alignment. 

• The accuracy of the alignment heading determines the accuracy of the whole survey until the next 
alignment. Position the alignment jig carefully and carry out the heading survey (or the alignment of the jig 
between two known points) as precisely as possible. The required heading is that pointing towards the nose 
of the probe. 

• Carry out a new heading alignment as often as possible. For the very best accuracy, realign before each 
hole. A reasonable target would be to align every three or four holes, but this will depend on the length of 
each deployment, the required accuracy for your project and the practical realties of positioning the 
alignment jig on your site. 

• In the example above, the probe was aligned between two holes of known coordinates. This will often be 
the most convenient method of establishing the heading in a quarry environment, but there are other options 
depending on your project site and the facilities available to you. See section 4.3. 

5.10.3 Horizontal and uphole deployments 

• If you are using a push rod system or Boretrak rods to deploy the probe, the probe should be detached from 
the deployment device before aligning the heading on the alignment jig. This ensures that the probe can sit 
cleanly in the jig and that the position of the jig is not disturbed.  

• For uphole deployments, you must use centralisers to hold the probe parallel to the sides of the hole. You 
may customise your own stabilisers to fit your local site requirements and hole sizes or, alternatively, contact 
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Carlson for advice on disposable fittings such as those shown below. 

 

Figure 32 Boretrak2 probe fitted with centralisers for uphole deployment 
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HARDWARE 
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6 Boretrak2 hardware description 

6.1 Probe 

 
The Boretrak2 probe contains an inertial measurement unit (IMU). The IMU comprises a triaxial accelerometer, 
magnetometer, and gyro. 
 
IMU readings are collected during a survey and stored in the probe’s on-board memory. The probe also contains a 
real-time clock which is synchronised with the clock on your mobile device. The clock is used to timestamp all 
recorded data. 
 
The Boretrak2 probe operates at any inclination. The IMU tracks the probe’s orientation whether it is deployed 
upwards, downwards, or horizontally. 
 
A ring of LEDs provides visible information on the status of the Boretrak2. The information conveyed is outlined 
below. 
 

LED behaviour Message signalled 

Yellow solid On power up – waiting for battery to stabilise 

Blue flashing Waiting for Bluetooth connection 

Red flashing Probe is not aligned or has lost alignment 

Yellow flashing Probe is aligned / logging is off 

Green flashing Probe is aligned / logging is on / ready to survey 

Red / green flashing For troubleshooting only 

Red / blue flashing For troubleshooting only 

Red / yellow blinking For troubleshooting only 

Red / cyan blinking Battery level too low to power up 

 
The Bluetooth signal is broadcast through the LED window. Try to avoid holding the probe by the LED window 
during operations as Bluetooth communications with the mobile device may be affected. 
 
The deployment adaptor provides a quick-release mechanism to attach to deployment devices. This connection 
ensures that the probe is secure during deployment and that attaching and detaching the selected deployment 
device is quick and efficient.  

Nose cone containing 
batteries 

LED 
ring 

Rod 
adaptor 

Serial 
number 

IMU  
(inside probe) 

Figure 33 Boretrak probe 
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The serial number of the probe is engraved on the side of the rod adaptor. 
 
The nose cone at the bottom end of the probe houses the batteries and should be unscrewed for transportation or 
for changing the batteries. 
 
The Boretrak2 probe is ruggedised but should be handled with due care to best protect the calibrated sensors inside 
the housing. 

6.1.1 Probe power 

The Boretrak2 probe is powered by three, size “D” (LR20) rechargeable batteries. With each Boretrak2 system, 
Carlson supplies 10,000mAh Ni-MH rechargeable Ansmann batteries as shown below. These particular batteries 
have been extensively tested in the Boretrak2 probe and are strongly recommended for use in all field operations. 
 
Ensure the batteries are fully charged prior to each day’s survey operations. 
 

 
These batteries are contained in the removable nose cone that is screwed onto the bottom end of the probe. 
 
Insert the batteries into the nose cone, ensuring that the positive terminals are facing the open end, as shown in 
Figure 35. Screw the nose cone onto the main probe using hand pressure only. The nose cone must be fully screwed 
home to ensure a watertight seal. 
 

Figure 35 Positive battery terminals face out 

Figure 34 Supplied rechargeable batteries 
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Indications of discharged batteries are: 

• The LEDs switch to solid yellow (battery too low to proceed with operations). 

• The LEDs do not activate when the nose cone is fitted (battery exhausted). 

• The tablet cannot establish communications with the probe as a remote Bluetooth device (battery 
exhausted). 

• A message in Carlson Boretrak software indicating that the battery level is critical or that there is not 
enough power to turn on the IMU. 

The probe is powered ON as soon as the nose cone is attached to the probe. Removing the nose cone powers the 
probe OFF.  
 
Note that there is a supercapacitor in the probe which allows the Boretrak2 to keep running if power is momentarily 
lost due to a sudden shock, or displacement of the batteries. Therefore, to fully reboot the probe, leave the nose 
cone disconnected for at least 20 seconds to allow the supercapacitor to fully discharge. 
 
As described in the table in section 6.1, when the Boretrak2 probe is powered ON, the LEDs will light up, initially 
yellow and then in a colour and pattern dependent on the current status of the probe.  
 
When a survey is complete, and data has been downloaded from the Boretrak2 probe to the tablet, remove the 
nose cone to preserve battery life. Data is automatically deleted from the probe after it has been downloaded. If 
data has not been downloaded, it is stored in the probe even when the probe is powered OFF. 
 

WARNING: only undamaged batteries should be used in the Boretrak2 probe. Prior to each use, check 
the condition of your battery cells. If the plastic coating around the battery is pierced, ripped or torn, do 
not load the battery into the probe. Dispose of the battery and source a Carlson-approved replacement. 

 

 
WARNING: dispose of used batteries sensibly. Under no circumstances must the batteries (or instrument) be 
disposed of by burning. Explosion may occur! 
 
WARNING: all batteries contain highly reactive, poisonous, and corrosive chemicals, which are hazardous if 
released due to physical damage. Should the battery or battery charger stop working or become damaged, stop 
using it and source a Carlson-approved replacement. 
  

Figure 36 An example of a battery with a damaged outer coating. This 
battery should not be used in the Boretrak2 probe 
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6.2 Grease 

The Boretrak2 probe incorporates a nose cone which acts as a battery compartment. This nose cone screws onto 
the probe and is sealed with an O-ring above the retaining thread.  
 

 
A tube of silicon grease is supplied with the Boretrak2. This grease should be lightly smeared on the O-ring to 
ensure it is kept well lubricated and the probe retains its seal. Keep grease off the retaining thread. 

6.3 USB drive 

 
A USB drive is supplied with the Boretrak2 system. This is loaded with: 

• Carlson Boretrak software for Windows. 

• Carlson Boretrak software for Android. 

• This Boretrak2 manual. 

Figure 37 Silicon grease 

Figure 38 USB drive 
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6.4 Transit case 

 

 
Components of the Boretrak2 system are contained within a dedicated transit case. The case ensures the system 
is protected from shocks and vibrations. When the lid is closed and the latches are snapped in place, the case is 
both dust-tight and water-tight (IP67). 
 
Always pack the Boretrak2 probe and accessories into the transit case for storage and transportation. 
 
Clean and dry the Boretrak2 probe and other accessories prior to packing them in the transit case. 
  

Figure 39 Boretrak2 transit case 
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6.5 Alignment jig 

A gyro alignment jig is supplied with all Boretrak2 systems.  
 

 
When in use, the gyro inside the Boretrak2 must be aligned before a deployment. The gyro is not a north-seeking 
device so an initial starting heading must be defined. The starting heading forms the basis of all subsequent 
orientation data collected over the course of a deployment. During the alignment routine therefore, the probe must 
be held in a position where the starting heading can be surveyed. 
 
The jig cradles the probe during this alignment and provides a baseline which can be used to survey an accurate 
heading. 
 
The heading entered in Carlson Boretrak software should be that pointing in the direction of the nose cone of the 
Boretrak2 probe. 
 
Spiked feet underneath the jig can be pushed into the ground to ensure it does not move. 
 
A 5/8” thread in the centre of the jig allows it to be mounted on a standard survey tripod. 
 

Figure 40 Gyro alignment jig (left) with probe during alignment (right) 
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Wherever the jig is positioned, if it is held securely in place, multiple, repeatable alignments can be taken from the 
same position. Also, if required, the jig can be left in place for a surveyor to observe with their total station after the 
deployment has been completed. 
 
Note that other customised devices which perform the same function as the alignment jig may be used if they are 
more suitable for your specific operations. 
  

Figure 41 Gyro alignment jig mounted on a survey tripod 
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6.6 Deployment adaptor 

The deployment adaptor allows the Borektrak2 probe to be directly connected to a variety of deployment devices. 
 

 
The 5/8” thread screws directly into female 5/8” threads on the supplied steel cable and on the optional push rod 
system. 
 
With the deployment adaptor connected to the selected deployment device, the adaptor can be connected to the 
Boretrak2 probe before commencing a survey. Retract the sprung brass cuff to reveal the quick release connection 
pin. 
 

 
To connect the deployment adaptor to the probe, hold the two at 90° angles. Push the quick release pin into the 
hole in the probe. Now straighten the probe so it is in line with the deployment adaptor.  
 

Figure 43 Deployment adaptor with brass cuff un-retracted (left) & retracted (right) 

Figure 42 Deployment adaptor 
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Allow the brass cuff to spring back into place, locking the Boretrak2 probe in line with the deployment adaptor.  
 

 
To disconnect the probe, retract the brass cuff, move the probe so it is at a 90° angle with respect to the deployment 
adaptor and disengage the probe from the deployment adaptor. 
  

Figure 44 Connecting the deployment adaptor to the probe 

 

Figure 45 Retracted deployment adaptor ready to connect to the probe  

Figure 46 Deployment adaptor connected to the probe 
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6.7 Steel cable 

The steel cable is supplied with all Boretrak2 units. This cable should be used for deployments along any borehole 
steep enough for gravity to pull the probe to the bottom of the hole. For shallower holes, or holes drilled horizontally 
or uphole, the steel cable is not suitable. In these cases, a push rod system should be used. 
 

 
The standard cable is 50m long. For deployments down boreholes longer than 50m, contact Carlson Software to 
enquire about cables of different lengths. 
 
A threaded brass cap on the end of the steel cable provides a connection point for the deployment adaptor. 
 
The steel cable is marked along its length by steel nodules and distance labels every metre. These are arranged in 
the order:  

• Yellow marker = 1m and subsequent odd metre intervals  

• Red marker = 2m and subsequent even metre intervals  

 
With the Boretrak2 probe connected to the cable, the first nodule along the cable from the probe is exactly 1 m from 
the tip of the Boretrak2 nose cone.  
 
On the other end of the steel cable a clip gives the option to attach the wire to a belt or fixed object in case there is 
concern that the probe might be dropped down the borehole. 

Figure 47 Steel cable 

Figure 48 Odd (left) and even (right) metre markers 
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The steel wire is supplied wound into a coil and packed into a cable bag. 
 

 

6.8 Push rod system (optional) 

The push rod system is used to push the Boretrak2 probe during horizontal or uphole deployments. It is also suitable 
for use in shallow, downhole deployments when the hole is not steep enough for gravity to pull the probe down the 
hole under its own weight. 

 
55 m of push rod is spooled in a cage held in a metal frame. The push rod is made of alkali-free fibreglass and high-
quality resin for flexibility and tensile strength. The exterior layer is covered with high density UV-resistant 
polyethylene. 

Brake lever 

Handle 

Brass cone 
connector 

Cable guide 

Frame 

Figure 50 Push rod system 

Figure 49 Steel cable spool in transit case 
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The push rod is marked with nodules at one metre intervals. These nodules aid accurate deployment of the 
Boretrak2 probe. Even numbers of metres are marked with red nodules, odd numbers with silver. 
 
A brass cone connector is fastened to the end of the push rod. Screw the deployment adaptor into the brass cone 
connector. The Boretrak2 probe can then be easily connected to the push rod. 
 
The standard push rod has a cross sectional diameter of 9 mm. The minimum bend radius of the push rod is 30cm. 
 
A brake lever on the side of the frame locks and unlocks the cage. Rotate the brake lever clockwise to tighten and 
anti-clockwise to untighten the rotation of the cage. Release the brake to deploy the push rod.  

 
WARNING: a large amount of energy is stored in the coiled fibreglass rod. Always maintain control 
over the free end of the rod when the brake is not applied. Always keep the brake lever locked 
when the push rod is not being deployed or recovered.  
 
WARNING: do not exceed the minimum bend radius of the push rod. 
 

For transportation, the push rod system is supplied dismantled. The frame must be assembled on receipt, before 
the system is used on site.  

6.8.1 Supplied parts 

The following parts are supplied as part of a push rod system. 
 

 
 

• 1 x Push rod frame 

• 1 x Frame handle  

• 1 x Wheel axle 

• 1 x Brake handle 

• 1 x Cable guide 

• 4 x Stud feet 

Wheels 

Wheel axle 

Brake handle 

Cable guide 

Frame handle Stud feet 

Clevis pins Nut, bolt and 
washer sets 

Figure 51 Push rod system - supplied parts 
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• 2 x Clevis pins 

• 2 x Rubber wheels  

• 2 x M6 x 40 mm screw with nut and washer 

• 4 x M6 x 35 mm screw with washer  

• 2 x M8 x 45 mm screw with nut and washer 

 
The tools required for assembly are: 

• 6 mm hex key  

• 5 mm hex key 

6.8.2 Assembly 

Thread the brake handle onto the hub of the drum axle. 
 

 
Hold the wheel axle against the push rod frame and align the holes in the axle with the holes in the frame. 
 

Brake handle 

Drum axle 

Figure 52 Assembling the push rod system - step 1 

Wheel axle 

Push rod frame 

Figure 53 Assembling the push rod system - step 2 
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Insert a M8 x 45 mm screw through both holes in the wheel axle. Secure the axle to the frame with a nut and washer. 
Tighten the screw with a 6 mm hex key. 
 

 
Slide a rubber wheel onto each side of the axle.  
 

 
 
 
  

Wheel axle secured 
with two M8 x 45 mm 
bolt, nut and washer 
sets 

Figure 54 Assembling the push rod system - step 3 

Figure 55 Assembling the push rod system - step 4 
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To secure the wheels in place, insert and secure a clevis pin through the hole on each end of the axle. 
 

 
Insert the handle into the connectors at the top of the frame. Ensure the holes in the handle are aligned with the 
holes in the frame. 
 

 
  

Clevis pin 

Figure 56 Assembling the push rod system - step 5 

Handle slotted 
into connectors 

Figure 57 Assembling the push rod system - step 6 
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Insert a M6 x 40 mm screw through the holes in each connector. Secure the handle to the frame with a nut and 
washer. Tighten the screw using a 5 mm hex key. 
 

 
Thread the cable guide onto the brass connector. 

 
  

Handle secured with 
M6 x 40 mm bolt, nut 
and washer sets 

Figure 58 Assembly of the push rod system - step 7 

Cable guide 

Figure 59 Assembly of the push rod system - step 8 
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To attach the optional stud feet to the frame, turn the frame on its side so it is resting on the handle. Attach the stud 
feet to the frame through the 4 holes in the base of the frame. Use the M6 x 35 mm screws with washers. Tighten 
the screws using the 5 mm hex key. 
 

 

6.9 Boretrak rods (optional) 

A series of hinged Boretrak rods may be used to push the probe in an uphole or horizontal deployment. 
 

 
The rods are produced in 1 m lengths. The exception to this is the ‘lead’ rod which is 0.3 m long. This shorter rod 
attaches directly to the probe. The length of the lead rod plus the probe is equal to 1 m. 

Figure 61 Rod rack with rods and probe attached 

Stud feet 

Holes in 
frame base 

Figure 60 Assembly of push rod frame - step 9 
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Rods are stacked in a rod rack. The rod rack can fit up to 36 rods, arranged in two stacks of 18. The rod at the 
bottom of each stack is fitted with a female quick-release joint. This joint can connect to the rod on the top of the 
next stack which is fitted with a male quick-release joint.  
 
To connect the quick-release joints, the two rods must be held at 90° angles. The pin in the male joint is then pushed 
into the hole in the female joint. Once the rods are straightened out beyond 90°, the joint is locked. To disconnect 
the rods, they must again be held at a 90° angle and pulled apart. 
 
 

 
For longer deployments, further racks full of rods can be used. The rods form each stack join together in the same 
way as described above. 
 
To allow the rods to be pushed, the rods are joined with uni-directional uphole links which prevent them from 
doubling back on themselves.  
 

 
When using the probe uphole, the length of the deployment may be restricted due to the weight of the system or 
the condition of the borehole. Uphole deployment is only suitable for narrow boreholes less than 100 mm diameter. 

Figure 62 Quick release joint 

Figure 63 Uni-directional uphole link 
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Rods can also be used for downhole deployments. In some cases, they may be helpful to prevent the probe twisting 
and spinning excessively. For downhole deployments, the rods can be joined with bi-directional links to make the 
articulation between rods more flexible.  
 
Proper use and care of the rods is essential to ensure the safety and longevity of the equipment (see section 7).  

6.10 Android devices (optional) 

An Android device can run the Carlson Boretrak application and interact with the Boretrak2 probe. 
 

 
An Android tablet or PDA can be supplied by Carlson as part of the Boretrak2 system. Carlson Boretrak is pre-
loaded on any such device supplied by Carlson. 
 
The devices supplied by Carlson change over time. Contact Carlson for details of options available. Alternatively, 
the customer can source a preferred Android device of their own. 
 
A dedicated ‘QuickStart guide’ for any supplied Android device is loaded onto the supplied USB drive. Please read 
that manual before using the Boretrak2 system. 

6.11 Windows tablet (optional) 

A Windows tablet can run the Carlson Boretrak application and interact with the Boretrak2 probe in the field.  
 
A Windows tablet can be supplied by Carlson as part of the Boretrak2 system. Carlson Boretrak is pre-loaded on 
any such device supplied by Carlson. Alternatively, the customer can source a preferred Windows device of their 
own. 
 
Currently, the RT4 is the tablet supplied by Carlson. The RT4 is IP68 which means that it is protected against dust 
ingress and waterproof to at least 1 m.  
 
Hardware touch buttons are located below the screen and can assist with navigation within Windows.  
 
A stylus, carry strap and screen protector are supplied with the RT4. 
 
A dedicated ‘QuickStart guide’ for the RT4 is loaded onto the supplied USB drive. Please read that manual before 
using the Boretrak2 system. 
 

Figure 64 PDA 
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7 Regular checks and preventative maintenance 

Carlson recommends that you carry out regular functional testing of the Boretrak2 system. Any damage, 
malfunctions or poor performance detected should be reported to Carlson. Also contact Carlson to arrange a yearly 
service and calibration. 
 
Where necessary, replacement accessories such as rods and cables can be purchased from Carlson or from your 
local Carlson representative. 
 
Before and after each session in the field, carry out routine checks of the system as outlined below. 

7.1 Probe 

Clean the probe thoroughly with warm soapy water. 
 
Ensure that the screw threads in the nose cone and body of the probe are free of dirt, grease and grit. 
 
Check the O-ring around the nose-cone thread. If there is any visible damage or breaks, it should be replaced with 
a new O-ring: size BS124 Fluorocarbon 75 (31.42 mm ID × 2.62 mm CS). 
 
Clean any dirt from the nose cone and O-ring seal. Lubricate the O-ring with the supplied silicone grease. 
 
Store within the specified environmental temperature limits. 
 
Only use battery cells which are in an intact condition. Prior to each use, check the condition of your battery cells. 
If the plastic coating around the battery is pierced, ripped or torn, do not load the battery into the Boretrak2 probe. 
Dispose of the battery and source a Carlson-approved replacement. 

7.2 PDA / tablet 

Recharge the internal battery after use. 
 
Check all ports and connectors to ensure that they are free from mud and water. 
 
Ensure that any battery or memory card covers are fully closed. The device is not environmentally protected if the 
cover is partially open. 
 
Store within the specified environmental temperature limits. 
 
Wherever possible, use a dedicated carry case or neck strap to keep the device protected and secure. 

7.3 Push rod 

Regularly inspect the push rod for signs of damage which could cause it to fail.  
 
The minimum bend radius of the 9mm push rod is 30cm. Do not exceed this bend radius. 

7.4 Rod stack 

Clean the rods by soaking thoroughly with warm soapy water. 
 
Ensure the rod joints are clear of mud and grit to maintain the condition of the rod stack. 
 



 

BT2 user manual - H-5911-9004-03-A   P a g e  | 57 

Check the rods and hinges prior to every deployment. Ensure that they are in good condition, that there is no 
apparent “twist” in the rods, and that all nuts and bolts and connecting pins are in place and secure. 
 
The nuts and bolts used to hold the hinges in place should be periodically checked and tightened to a torque of 1.5-
1.8 Nm. If necessary, a small amount of thread-locking compound (Loctite 270) can be used, but it must not be 
used on the hinge itself. 
 
Should any rod approach end-of-life, or become non-functional or damaged, stop using it immediately and request 
a replacement from a Carlson-approved service centre. 
 
The rods and hinges are designed to be used predominantly in the plane of the rack. They are designed to be load-
bearing along their length (tensional loads) so can withstand the weight of a long Boretrak2 deployment. However, 
take care not to force the rods in a twisting action (torsional loads) or a lever action (transversal loads). 
 
Side pressure, dragging the rods against the collar or excessive leverage on the rods will weaken the system and 
reduce rod life or even result in unexpected breakage. 

7.5 Transportation 

In addition to the points above, care should be taken when transporting the Boretrak2 system. 
 
Always pack the Boretrak2 system into the transit case supplied for storage and transportation.  
 
Clean and dry the Boretrak2 probe and other accessories prior to packing them in the transit case.  
 
When transporting the rods, ensure they are packed into a dedicated rod case or other suitable container. 
 
Do not allow the equipment to slide around inside transport vehicles or containers. 
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SOFTWARE 
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8 Setting up Carlson Boretrak software on an Android device 

Carlson Boretrak software runs on a Windows or Android mobile device or on a Windows PC. This section 
describes the process of installation and setup on an Android device. Section 9 describes the same process on a 
Windows device. 
 
The most recent version of Carlson Boretrak is always available from the downloads section of Carlson’s website. 
Go to:  
 

https://web.carlsonsw.com/files/updates/updates05.php 
 
Select Carlson Boretrak for Android from the dropdown list and download the *.APK file. 

8.1 Licensing and registration 

Carlson Boretrak has a non-restrictive distribution license, so it may be installed on as many tablets as required. 

8.2 Recommended specs 

If you have opted to purchase a Boretrak2 system without a mobile device, you must supply your own device to run 
Carlson Boretrak. Before selecting such a device, please consider the following points: 

• The device should run Android version 7.0 – Nougat – or above. Android version 5.0 – Lollipop – can run 
Carlson Boretrak with limited graphic capabilities. 

• Any device used in the field should be highly ruggedised to withstand the harsh conditions that are typical 
for the applications in which the Boretrak2 hardware is used. An environmental protection rating of at least 
IP65 is recommended. 

• The battery capacity of the device should allow you to operate for a full day in the field. 

• Carlson Boretrak is adaptable to different sizes of screen but consider whether your operation will benefit 
from detailed visual analysis of data in the field. In this case, bigger tablet screens are preferable. 
Alternatively, the only concern in the field may be efficient data collection, in which a small PDA would 
suffice. 

• Given the nature of Boretrak2 deployments, it is important that you should be able to attach a neck or wrist 
strap to the device to allow you to have both hands free when appropriate. The attachment will often need 
to be to a separate case which in turn contains the device. 

• Features improving the readability of the screen in sunlight, and the response of the touchscreen in rain are 
useful.  

• Users running mobile devices which have been supplied as part of a Boretrak2 system can be fully 
supported by Carlson. It may be more difficult to support devices which have not been tested and used by 
Carlson support staff. 

8.3 Recommended PDA settings 

On receipt of a new Boretrak2 system, no changes of any Android settings are required to run the PDA as part of 
the Boretrak2 system. However, it is recommended that you set the correct time and date for your region. 
 
If you have purchased your own PDA you may wish to ensure that the settings below are reviewed and configured, 
depending on your operational requirements. Note that these settings differ between devices. 
 

https://web.carlsonsw.com/files/updates/updates05.php
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From the Settings icon: 

• Date and time: either connect to a Wi-Fi network to synchronise time, or manually set the time and date to 
ensure all Boretrak Mobile projects are correctly time-stamped for your local region. 

• More > Aeroplane mode: turn ON to disable mobile phone operation. This will help prolong battery life. 

• Wi-Fi: turn OFF to prolong battery life. 

• Bluetooth: must be ON to operate the PDA with the Boretrak2. 

• Display > Adaptive brightness: turn ON to ensure the screen automatically brightens when in sunlight. 
Turn OFF and reduce brightness to save battery power. 

• Display > Sleep: set to Never to ensure the screen does not turn off during operations. 

• Accessibility > High contrast text: turn ON or OFF to change text visibility if appropriate. Some screens 
in Carlson Boretrak may appear distorted in some circumstances if this setting is switched on. 

• Close all other applications when using Carlson Boretrak, to prolong battery life and reduce the chance of 
conflict. 

8.4 Installing and updating Carlson Boretrak 

If you have purchased a Boretrak2 system without an Android device then you must install the Carlson Boretrak 
application on your own device. Instructions for doing this are below. 
 
Whether or not you are using your own device, future software updates may be released in which case you will also 
need to follow these instructions.  
 
Please note that details of the Android screens and the installation process may change slightly depending on the 
specific device chosen and on the version of Android that you are using. A typical process is described below. 
 
The new installer is supplied as an *.APK file which is loaded onto the Carlson USB drive supplied with each 
Boretrak2 system. Connect the device to your PC using a USB cable. Copy the *.APK file from your PC to the root 
drive of the device (Figure 65). 
 

 
On the device, tap on the Settings icon and select Storage and USB > Explore. Within the Internal Storage 
screen, navigate to the *.APK file. 

Figure 65 Locating the Boretrak Mobile installer 
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Tap the *.APK file. The app begins installing. 
 
An Installing… message appears followed by an App Installed message.  
 
During the installation, the installer asks: Allow Boretrak to access this device’s location? 
 
Click Allow. 
 
The installer asks: Allow Boretrak to access photos and media on our device? 
 
Tap Allow. 
 
An icon is loaded onto your Home screen. Double-tap the icon to open Carlson Boretrak. 
 

8.5 Pairing a Boretrak2 probe with the PDA 

The Android device and the Boretrak2 probe communicate via a Bluetooth connection. For this connection to 
operate, the device and Boretrak2 probe must be ‘paired’.  
 
When purchased as a complete system, the Boretrak2 is supplied ready to use, with the Bluetooth connection 
already established. However, if you have purchased your own device or, if you are reconfiguring a device or swapping 
over a probe, you may find it necessary to establish / re-establish communications. 
 
The Boretrak2 probe must be powered ON. 
 

Figure 66 *.APK file in Internal storage 

Figure 67 Carlson Boretrak icon 
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In your device, tap Settings > Bluetooth. Ensure the Bluetooth function is turned ON. 
 
The Boretrak2 probe is identified over Bluetooth by its serial number. To operate in conjunction with the PDA, the 
probe must be listed as a Paired device (Figure 68). 
 

 
All Bluetooth devices which the device can see, but which are not paired, are listed as Available devices. 
 
Identify the correct entry in the list of available devices. Tap the serial number to pair the device with the probe. 
 
A Bluetooth pairing request appears (Figure 69). Tap OK. 
 
A pairing code is required but this will be pre-entered by default. Tap Pair. The device pairs with the Boretrak2 
probe. When successful, the Boretrak2 probe is listed under Paired devices. 
 

 
If the Boretrak2 probe is not listed under paired devices or under available devices, check that: 

• The Bluetooth function is ON. 

Figure 68 The Boretrak2 in the list of available devices 

Figure 69 Boretrak2 pairing request (left); Boretrak2 a paired device (right) 
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• The Boretrak2 probe is powered ON and LEDs are flashing red. 

• The Boretrak2 probe is within 2 m of the device, with no obstructions between them. 

• There are no obstructions over the Boretrak2 probe’s LED window. 

When you have checked each of these points, in the Bluetooth screen, tap Scan to check again for the Boretrak2 
probe. 

8.6 Data storage and file formats 

By default, projects created in Carlson Boretrak on an Android device are saved in the location: 
<AndroidDevice>:\Internal shared storage\Documents\Carlson Boretrak. 
 
Connect the device to a PC to see the projects listed in the device. 

 
The default location can be changed through the Settings window > General tab (see section 11.3.1). 
 
Note that before a project is manually saved, it is automatically saved in <AndroidDevice>:\Internal shared 
storage\Carlson Boretrak\_Unsaved Projects. After the project is manually saved, it is moved to its own project 
subdirectory. 
 
A dedicated folder structure is created for every Carlson Boretrak project. All data collected in a project is stored 
in the project folder or sub-folders. 
 
The main project file is saved as *.NDV directly in the project folder. Open this file from within Carlson Boretrak by 
using the Open function.  
 
Projects created in the Windows and Android versions of Carlson Boretrak are compatible, so the *.NDV file can 
be swapped between applications and devices. 
 
Other files are stored in sub-folders: 

• Backup: while a project is active, a backup file is stored here and continually updated. This ensures all data 
is secure and allows recovery in case of a hardware or software failure. Files in this folder are time/date 
stamped with <most_recent.ndv> being the last recorded backup.  

• Exports: by default, any exports generated from a project are stored here.  

• Logs: during data collection operations, detailed logs are kept of communications with the scanner. These 
may be used for support and troubleshooting. 

• Reports: reports created within the app are stored here. 

Data can be copied from the Android device by connecting the device to a Windows PC and using Windows 
Explorer. 
 

Figure 70 A Carlson Boretrak project on an Android device displayed in Windows Explorer 
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Alternatively, in Carlson Boretrak, go to the Menu and select Send. A series of options are offered to send the 
project, or elements of it via different medium – Bluetooth, Wi-Fi, or Cell, depending on the options configured and 
available on your device. 
 
If problems are encountered with the hardware, software, or any collected datasets, then it may be necessary to 
contact Carlson for support. In this case you may be requested to send the entire, zipped project folder. This will 
help to ensure the highest level of support. 
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9 Setting up Carlson Boretrak software on a Windows device 

Carlson Boretrak software runs on a Windows or Android mobile device or on a Windows PC. This section 
describes the process of installation and setup on a Windows device. Section 8 describes the same process on an 
Android device. 
 
The most recent version of Carlson Boretrak is always available from the downloads section of Carlson’s website. 
Go to:  
 

https://web.carlsonsw.com/files/updates/updates05.php 
 
Select Carlson Boretrak for Windows from the dropdown list and download the *.EXE file. 

9.1 Licensing and registration 

Carlson Boretrak has a non-restrictive distribution license, so it may be installed on as many devices as required. 

9.2 Recommended specs 

Carlson Boretrak can be run in Desktop mode which is designed to be used in an office environment in conjunction 
with a standard mouse, keyboard and large monitor.  
 
Carlson Boretrak can also be run in Touch mode. This mode is optimized for use in the field on a touch-screen 
tablet.  
 
Carlson can supply Boretrak2 systems packaged together with a Windows tablet, suitable for field use. This tablet 
is pre-installed with Carlson Boretrak software and pre-configured to optimize performance. 
 
Alternatively, if you are independently selecting a Windows-based tablet to run Carlson Boretrak, consider the 
following points when making your choice.  

• Carlson Boretrak runs on 64-bit Windows PCs running Windows 10. 

• The main compatibility requirement for Carlson Boretrak to run optimally is that the processor / GPU should 
be able to support Vulkan API. A list of processors and GPUs compatible with Vulkan in Windows, is shown 
here: https://en.wikipedia.org/wiki/Vulkan_(API)#Compatibility. Processors which do not support the Vulkan 
API may run Carlson Boretrak with limited graphic capabilities. 

• Any tablet used in the field should be highly ruggedised to withstand the harsh conditions that are typical 
for the applications in which the Boretrak2 hardware is used. An environmental protection rating of at least 
IP65 is recommended. 

• The battery capacity of the tablet should allow you to operate for a full day in the field. 

• 300 MB free space is required on your tablet’s hard disk to install the software. 

• 2 GB is the minimum recommendation for RAM installed in your tablet. 

• Carlson recommends that you ensure that all Windows updates are current and that the latest drivers for 
your graphics card are installed. Failure to update components may result in video or driver errors. 

• Given the nature of Boretrak2 deployments, it is important that you should be able to attach a neck strap to 
the tablet to allow you to have both hands free when appropriate. 

• Features improving the readability of the screen in sunlight, and the response of the touchscreen in rain are 
useful.  

https://web.carlsonsw.com/files/updates/updates05.php
https://en.wikipedia.org/wiki/Vulkan_(API)#Compatibility
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• Users running tablets which have been supplied as part of a Boretrak2 system can be fully supported by 
Carlson. It may be more difficult to support devices which have not been tested and used by Carlson support 
staff. 

9.3 Recommended settings in a tablet 

• Date and time: either connect to a Wi-Fi network to synchronise time, or manually set the time and date to 
ensure all Carlson Boretrak projects are correctly time-stamped for your local region. 

• Wi-Fi: turn OFF to prolong battery life. 

• Bluetooth: must be ON to operate the tablet with the Boretrak2. 

• Display > Adaptive brightness: turn ON to ensure the screen automatically brightens when in sunlight. 
Turn OFF and reduce brightness to save battery power. 

• Display > Sleep: set to Never to ensure the screen does not turn off during operations. 

• Close all other apps when using Carlson Boretrak to prolong battery life and reduce the chance of conflict. 

9.4 Installing Carlson Boretrak 

If you ordered a rugged tablet from Carlson as part of a Boretrak2 purchase, Carlson Boretrak is already loaded 
on the tablet. 
 
If you are supplying your own tablet, you must install the software before using your Boretrak2 for the first time. 
 
The Carlson Boretrak installer is loaded onto the USB drive packaged with all Boretrak2 systems. Updates are 
made available online. 
 
The installer is supplied in the form of an *.EXE file. Double-click on the file to run the installer. 
 

 
Click Install, Next and then accept the license after a careful review.  
 
Click Install. The software and all necessary dependencies are loaded onto your tablet. 
 
By default, Carlson Boretrak is installed at: C:\Program Files\NDEVR\Carlson Boretrak\. 
 
An icon is loaded onto your desktop. Double-click the icon to open Carlson Boretrak. 

Figure 71 Carlson Boretrak setup screen 
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9.5 Pairing a Boretrak2 probe with the tablet 

The Windows tablet and the Boretrak2 probe communicate via a Bluetooth connection. For this connection to 
operate, the tablet and Boretrak2 probe must be ‘paired’.  
 
When purchased as a complete system, the Boretrak2 is supplied ready to use, with the Bluetooth connection 
already established. However, if you have purchased your own tablet, or if you are reconfiguring a device or swapping 
over a probe, you may find it necessary to establish / re-establish communications. 
 
The Boretrak2 probe must be powered ON. 
 
In your tablet go to Settings > Bluetooth & other devices. Ensure the Bluetooth switch is turned ON. 
 

 
The Boretrak2 probe is identified over Bluetooth by its serial number. To operate in conjunction with the PDA, the 
probe must be listed under Other devices. 
 
Tap Add Bluetooth or other device. The Add a device window appears. 

Figure 72 Carlson Boretrak icon 

Figure 73 Settings > Bluetooth and other devices 
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Tap Bluetooth. Windows searches for all Bluetooth devices within range. Your Boretrak2 probe appears on the list. 
 

 
Tap the Boretrak2 probe on the list. Windows connects to the probe and the devices are paired. 

9.6 Data storage and file formats 

A Carlson Boretrak project is saved as an *.NDV file. You can open this file from within Carlson Boretrak by using 
the Open function. Alternatively, double-click on the file in Windows Explorer to automatically open the selected 
project inside Carlson Boretrak. 
 
Projects created in the Windows and Android versions are compatible, so the *.NDV file can be swapped between 
applications and devices. 
 
By default, projects created in Carlson Boretrak are saved in the location:  
 

C:\Users\<username>\Documents\Carlson Boretrak. 

Figure 74 Add a device 

Figure 75 Select the Boretrak2 probe 
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The default location can be changed through the Settings window (see section 11.3.5). 
 
Note that before you manually save the project, it is automatically saved in the temporary location: 
 

C:\Users\<username>\Documents\Carlson Boretrak\_Unsaved Projects. 
 
Once you have manually saved the project, it is moved to the default Carlson Boretrak directory. 
 
Other files are stored in sub-folders underneath the default Carlson Boretrak directory: 

• Backup: while a project is active, a backup file is stored here and continually updated. This ensures all data 
is secure and allows recovery in case of a hardware or software failure. Files in this folder are time/date 
stamped with <most_recent.ndv> being the last recorded backup.  

• Logs: during data collection operations, detailed logs are kept of communications with the scanner. These 
may be used for support and troubleshooting. 

• Exports: a default folder to contain exports can be defined in the Settings window (see section 11.3.5).  

If problems are encountered with the hardware, software or any collected datasets, then it may be necessary to 
contact Carlson for support. In this case you may be requested to send the *.NDV file for further analysis and 
troubleshooting. This will help to ensure the highest level of support. 
 
Access the project location from within Carlson Boretrak by tapping Browse in the Menu tab (see section 13.1). 
Windows File Explorer opens at the address of the active project. 

Figure 76 A Carlson Boretrak project in Windows Explorer 
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10 Carlson Boretrak - Introduction 

Carlson Boretrak is designed to offer control over the Boretrak2 system and to provide versatile functionality for 
collecting, managing and reviewing data collected during field operations. 
 
Carlson Boretrak runs on a Windows tablet / PC or on an Android device. The detailed description of the software 
in this manual focuses on the Windows version, but both versions run in an almost identical way. 
 
Some additional notes on differences in the Android version are in section 17.  

10.1 Viewing modes 

On a Windows device, Carlson Boretrak is designed to be used with a choice of two viewing modes: Touch and 
Desktop. 
 
The mode can only be selected when first starting up the software. A Desktop button is available on the Touch 
mode Home screen (section 11). A Touch button is available in the Desktop tool bar when first starting the software 
(section 16 ).  
 
The option to swap modes is only available prior to opening an existing project or starting a new project. Once a 
session has begun, to swap modes, you must first close the software down and then reopen to access the relevant 
button. 
 
Unless specified, screenshots in this manual show Carlson Boretrak being used in Touch mode. 

10.1.1 Touch mode 

Touch mode is optimised to be used on a touch-screen tablet. It is recommended that Touch mode be used when 
collecting data in the field. The relevant controls for controlling the Boretrak2 deployment are made easily accessible 
through large format buttons. Features less used in the field are kept clear from the main interface. Some 
functionality such as editing is not available in Touch mode. 
 
In Touch mode, dedicated on-screen keyboards and number pads appear at any time manual data entry is required.  
 
The keypads include buttons to progress to the next field or to go back to the previous field. The number pad can 
also be used as a calculator if required. 

10.1.2 Desktop mode 

When a project has been completed, the data is usually viewed and analysed back in the office. In this case, if you 
are using a larger format laptop or desktop computer then select Desktop mode. 
 
Desktop mode has a more traditional Windows interface and is intended for use with a standard keyboard and 
mouse. 
 
Desktop mode makes use of extra screen space by making more information available on-screen, and by allowing 
multiple viewing windows to be shown simultaneously.  
 
More functionality for editing the data is accessible through the Desktop mode (see section 16). 



 

BT2 user manual - H-5911-9004-03-A   P a g e  | 71 

11 Touch mode – Home screen 

When Carlson Boretrak is first opened in Touch mode, the Home screen appears. 
 

 

11.1 New 

Tap New to create a new, Carlson Boretrak project.  
 
The Project window opens (see section 14.1). Edit the details as required. You can enter hole positions in advance, 
give the project an appropriate name and change the default folder location.  
 
By default, the project is named <Project YY-MM-DD HH MM>. 
 
Tap Create to accept the entered details and create a new project. 
 
Carlson Boretrak immediately runs an auto-detect process to identify any Boretrak2 probe which has been paired 
to the tablet and which is currently powered ON.  
 
When a Boretrak2 is identified, the connection is made.  
 
The Hole Setup window appears (see section 14.2.1). Enter your hole coordinates, or just accept the default values. 
Tap Finish. 
 
The main Touch mode interface appears with the 3D View on the left-hand side of the screen and the Control tab 
on the right-hand side. 
 
The probe is displayed graphically on screen, located at the newly generated station. The Boretrak2 deployment is 
now ready to begin. 

Figure 77 Touch mode Home screen 
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To import existing data into the project, open the Menu tab and select Open. 

11.2 Open 

From the Home screen, tap Open to open an existing Carlson Boretrak project. An Open dialog appears.  
 
Select the appropriate project from the recent files list. Alternatively, tap Browse Files to open an Open File 
windows dialog. Browse to the project location and select the *.NDV file to open the project in Carlson Boretrak. 
 
On opening a project, you can reconnect to a Boretrak2 via the Find Boretraks button on the Control tab (see 
section 15) or through the Project Details window (see section 14.1). 
  

Figure 78 New project - ready to deploy 
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11.3 Settings 

Tap Settings to view or edit software configuration settings. The Settings window appears.  
 
There are tabs along the side of the screen which group together different categories of controls. 
 

11.3.1 General 

The General tab collects together settings affecting the general operation of Carlson Boretrak software. 
 

• User name: enter the name of the operator. This appears on reports and saved project information. 

• Use GPS: this feature allows Carlson Boretrak to interact with Carlson Surv-PC when using a GNSS system 
to survey the position of collar coordinates. Turn ON the Use GPS switch to activate the Projections tab in 
the Settings window.  

Note that the GPS integration is currently a beta feature which is available to use on the understanding that 
it is still under development. Contact Carlson for further information. 

• Language: select from the list of available language options. If you would like to see additional language 
options in the list, please contact Carlson to make a request. 

• Updates: Carlson Boretrak automatically checks for new versions when the tablet is connected to a 
network. If a new version is available, hit the update button to download and update the software version. 

• Reset to Factory Defaults: restores Carlson Boretrak software to the state of a fresh installation. 

• Create Background: creates a ‘Carlson’ desktop wallpaper for your device. 

Figure 79 Settings > General 
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11.3.2 Boretrak 

The Boretrak tab collects together settings specifically concerning the operation of the Boretrak2. 
 

 

• Automatic naming – hole: select the naming convention for new holes. The Custom option allows you to 
specify a project or site-specific hole-naming convention. 

• Automatic naming – row: select the naming convention for new rows. The Custom option allows you to 
specify a project or site-specific row-naming convention. 

• Use last reading dialog: toggles the nature of the deployment procedure when the probe reaches the end 
of a hole.  

o On (default): standard Boretrak procedure – reach the end of the hole, take the last reading, then 
enter an offset value. 

o Off: standard C-ALS procedures – reach the end of the hole, enter a custom deployment interval, 
then take the last reading. 

• Auto Download: toggles the auto download feature ON (default) and OFF. If this feature is off then the 
downloads from the probe to the device must be manually triggered.  

• Auto Disconnect: toggles the auto disconnect feature ON (default) and OFF. If this feature is on then the 
probe will automatically disconnect from the tablet as soon as a deployment is started.  

• ASCII downloads: this feature is for support and troubleshooting purposes only. 

• Gyro Quality factor: this feature is for support and troubleshooting purposes only. 

• Maintenance Password: this feature is for support and troubleshooting purposes only. 

  

Figure 80 Settings > Boretrak 
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11.3.3 Projection 

The Projection tab is only visible if the Use GPS switch in the General tab is turned ON. The Projection tab allows 
you to set the geodetic parameters of the GPS data being used. 
 

 

Note that the GPS integration is currently a beta feature which is available to use on the understanding that it is still 
under development. Contact Carlson for further information. 

 
  

Figure 81 Settings > Projection 
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11.3.4 Units 

The Units tab allows you to set the units of measurement for your project. 
 

 

• Metric: tap to set all units to default metric measurement units. 

• Imperial: tap to set all units to default imperial measurement units. 

• Select the coordinate system from: 

o ENH: Easting, Northing, Height (x, y, z) 

o NEH: Northing, Easting, Height (y, x, z) 

o WSH: Westing, Southing, Height (x, y, z) 

o XYZ: Easting, Northing, Height (x, y, z) 

o YXZ: Northing, Easting, Height (y, x, z) 

• Unit: select from: 

o Metres 

o Feet 

o US Survey Feet 

o Inches 

o Centimetres 

• Surface area unit 

Figure 82 Settings > Units 
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o Square Feet 

o Square Metres 

o Square Yards 

o Square Inches 

o Square Kilometres 

• Volume Unit 

o Cubic Feet 

o Cubic Metres 

o Cubic Yards 

o Cubic Inches 

o Litres 

o US Gallons 

• Angular unit: 

o Decimal degrees 

o Degrees minutes 

o Degrees, minutes, seconds 

o Radians 

o Gradians (gons) 

• Heading: define the 0° reference direction: 

o North 

o East 

o South  

o West 

• Define the direction of horizontal angle measurement: 

o Clockwise 

o Anti-clockwise 

• Inclination Unit: define the angle define by a horizontal inclination: 

o Horizontal = 90° 

o Horizontal = 0° 

• Define the direction of vertical angle measurement: 

o Upward positive 

o Downwards positive 
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• Deployment Length: define the units used to deploy the Boretrak2: 

o Meters 

o Feet 

o US Survey Feet 

o Inches 

o Centimeters  
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11.3.5 Folders 

The Folders tab defines the storage location of Carlson Boretrak projects on your tablet.  
 

 
By default, Carlson Boretrak uses project files, as described in section 9.6. The Use Project Files radio button is 
selected by default.  
 
Files are stored in the folder listed below: 

• Project Root Folder: stores the main NDV project file. 

• Log Folder: stores the log files for troubleshooting & diagnostics. 

• Default Export Root: stores data files exported from the main project. 

• Backup Folder: stores ongoing backup files which ensure that no data is ever lost. 

 
To change the default location in which projects, logs, exports or backups are stored, tap the appropriate Choose 
Folder button. To view the contents of a folder, tap the appropriate Browse Folder button. Windows Explorer 
opens, showing the contents of the selected folder. 
 
Select Use Project Folders to collect each project in a folder together with the corresponding logs, exports reports 
and backups. 
  

Figure 83 Settings > Folders 
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11.3.6 Interface 

The Interface tab collects together settings which determine the appearance of Carlson Boretrak on your tablet. 
 

 

• UI scale: select a scale to ensure a best fit for Carlson Boretrak on your tablet. 

• Text scale: select a scale to ensure a best fit for Carlson Boretrak on your tablet. 

• Animation Speed: control the appearance of transitions between various tabs, controls, and windows. 

• Icon pack: change the appearance of all icons though out Carlson Boretrak. 

• Screen layout – Bottom section: in Desktop mode, activates a frame at the bottom of the screen for scan 
information. 

• Screen layout – Moveable tabs: allows side tabs to be undocked. 

• Screen layout – tabs on left: position tabs on the left-hand side of the screen. 

• Screen layout – tabs on right: position tabs on the right-hand side of the screen. 

• Touch settings – Keypad: activate the onscreen keypad for data entry. 

• Touch settings – Fullscreen: toggle between fullscreen mode and window mode. 

• Touch settings – Sound: toggle sound affects ON and OFF. 

• Touch settings – Speech: toggle spoken reports during a deployment ON and OFF.  

• Touch settings – Show exit: enable or disable the Exit button in the Menu tab and the Home screen. 

 
  

Figure 84 Settings > Interface 
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11.3.7 Graphics 

The Graphics tab collects settings relating to graphics performance. 
 

 

• Pixel thickness: change the thickness of lines displayed in the 3D View. 

• Near plane: the closest distance from your viewpoint that is rendered in the 3D View. 

• Far plane: the furthest distance from your viewpoint that is rendered in the 3D View. Large distances can 
be displayed but may be at the expense of the rendered resolution. 

• Frame rate: the number of frames to be displayed in the 3D View per unit of time is expressed in frames 
per second (fps). 

• Anti-aliasing: by default, the anti-aliasing check box is ticked on. You may wish to untick the check box if 
you are troubleshooting graphics display issues on your mobile device. 

• Default colours: select the colours which are used to shade the survey data and models in the project. 
Background selects the background colour for the 3D View. The Max, Mid and Min values refer to different 
qualities depending on the colour scheme selected. 

  

Figure 85 Settings > Graphics 
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11.3.8 Hole 

The Hole tab deals with default settings for hole creation. All settings can also be configured on an individual hole-
by-hole basis through the Hole Details window (see section 14.2).  
 

 

• Default Hole Location: defines the coordinates which are used when a hole is automatically generated by 
Carlson Boretrak. These can be changed at any time before or after a survey. You may find it convenient 
to enter default station coordinates which are close to those of your local mine coordinate system. 

• Enabled Heading Options: toggle ON or OFF the following options. When toggled ON, they appear in the 
alignment window: 

o None: heading is set to zero. 

o Known Heading: manually enter a heading value. 

o Back Point: manually enter a ‘back point’. A heading is computed from the back point to the 
currently selected hole collar.  

o Two Point: manually enter a back point and a front location. A heading is computed from the back 
point to the front location.  

o Relative: Select two hole collars. A heading is computed between the two holes. 

• Optional Features: these features are not currently active. 

o Custom Prism 

o Show Line of Site 

• Hole Text: sets elements of the appearance of a hole collar in the 3D View. 

o Show Title: labels the hole. 

o Show ranges: labels the ranges from the hole collar. 

o Show Axes: labels the XYZ axes centred on the hole collar. 

Figure 86 Settings > Hole 
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o Font controls: customise the font used for the hole labels. 

• Hole Linework: Sets elements of the appearance of a hole collar in the 3D View. 

o Default decoration: select the default appearance of a hole collar in the 3D View. Either a square 
grid or a circular target centred on the hole. 

o Range Lines: displays range rings centred on the hole collar. 

o Show Axes: displays axes centred on the hole collar. 

o Max radius: sets the maximum radius to which the range lines expand during a deployment. 

11.3.9 Imports 

The Imports tab lists all file formats which can be imported into Carlson Boretrak. Tap on any import to define 
default options for each format.  
 
These settings can also be altered during each individual import. 

11.3.10 Exports 

The Exports tab lists all file formats which can be exported from Carlson Boretrak. Tap on any export to define 
default options for each format.  
 
These settings can also be altered during each individual export. 
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11.3.11 Keystrokes 

The Keystrokes tab lists common actions in Carlson Boretrak and allows you to assign shortcut keys to each of 
these actions. This enables you to utilise hardware buttons on your mobile device to activate actions such as taking 
a reading or finishing a hole. 
 

 
To assign a shortcut key, tap on any of the existing shortcut buttons in the Keystroke tab. Press the button or 
combination of buttons you would like to use for the associated action. This shortcut now replaces the previous 
shortcut key. 
 
You can assign the same button to actions which are encountered at different stages of a deployment operation. 
For example, a Function key may be assigned to ‘Take Reading’ and also to ‘Download Data’ as these actions are 
never offered as onscreen options at the same time. 
  

Figure 87 Keystrokes 
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11.4 About 

Tap the About button to access help documentation and program information. 
  

 
There are three tabs at the top of the About window: About, Manuals and License. 

11.4.1 About 

The About tab displays details of Carlson Boretrak including the version number which should be quoted during 
any support query to Carlson. 
 
If your tablet is connected to the internet, the Update button reports any new software versions that are uploaded 
to Carlson’s website. If available, tap the Update button to download the new version. 

11.4.2 Manuals 

The Manuals tab provides access to this Boretrak2 software manual. 

11.4.3 License 

Displays the end-user license agreement. 

11.5 Light / Dark 

Three colour themes are available for Carlson Boretrak. During in-field operations, whether it be underground or 
in bright sunlight, you may find that one theme gives a clearer view of the screen. 
 
Tap the Light / Dark button to change the theme to toggle between Light, Dark and Black. 

Figure 88 About window 
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11.6 Desktop 

Tap the Desktop button to change to Desktop mode. Carlson Boretrak automatically restarts and opens in 
Desktop mode (see section 16). 

11.7 Exit 

Tap the Exit button to close Carlson Boretrak. 
 

Figure 89 Carlson Boretrak Home screen with Light (left), Dark (centre) and Black (right) colour themes 
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12 Touch mode – screen layout 

In Touch mode, a standard screen layout is composed of the elements outlined below. 
 

 
Note that you may use the options in the Settings window to modify the appearance from the default layout shown 
in this manual (see section 11.3.8).  
 
Also note that the screen will look different depending on the model and screen-size of the device on which Carlson 
Boretrak is running. 

12.1 3D View 

The main 3D View window shows all data graphically as it collected in real-time. This includes deployments, stations 
and design holes. 
 
Initially the 3D View shares the screen space with one of the function tabs. Retract the active function tab to switch 
the 3D View to full screen (see section 12.4). 
 
Navigation in the 3D View is by intuitive dragging and tapping or, alternatively, by mouse. 

• Zoom in / out: pinch / expand gestures with two fingers; roll the scroll wheel on a mouse. 

• Rotate: drag with a finger; click and drag with a mouse. The centre of rotation is the point at which you first 
touch the screen to rotate. 

• Pan: hold and drag with a finger; click and drag with the right button on a mouse. 

Elements visible in the 3D View are outlined below. 
 

3D View 
tabs 

3D View 

Selected 
function tab 

Function 
tabs 

View 
buttons 

Station and 
deployment 

Figure 90 Touch mode screen layout 
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12.1.1 Background colour 

The background colour is black by default. Change the background colour in the Settings window (see section 
11.3.7). 

12.1.2 Boretrak2 model 

A model of the Boretrak2 is shown on screen while the Bluetooth connection is live. Once the gyro has been aligned, 
the internal sensors allow the model to be correctly orientated in real-time, showing the heading and inclination of 
the probe. As the Boretrak2’s LEDs change colour, this is also reflected in the 3D View.  
 

 

12.1.3 Holes 

Holes represent hole collars which have been positioned with surveyed coordinates or with arbitrary coordinates 
generated within Carlson Boretrak. In the 3D View, the location of these coordinates is marked by a Hole graphic. 
 

Figure 91 Boretrak2 model 
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The Hole is the point at which the deployment begins. By default, these are represented in the 3D View by 
concentric circles which expand as the deployment progresses. 
 
The Hole graphic includes text identifiers, grid lines or concentric circles, and an X (green), Y (blue), Z (red) axis. 
 
The display of Hole graphics can be reconfigured in the Settings window > Hole tab (see section 11.3.8). 
 
The Project tab contains controls to turn Holes on and off in the 3D View window (see section 14). 

12.1.4 Planned holes 

A Planned hole is attached to a specific Hole. Planned holes can be configured in the Hole Details window (see 
section 14.2). Planned holes can be compared to surveyed holes to compute a deviation value along the length of 
a deployment. 
 
The Planned hole is displayed in the 3D View as a solid blue line. 

12.1.5 Deployments 

A Deployment is attached to a specific Hole. As the Boretrak2 is deployed, Boretrak readings are taken. These 
readings are all visible on-screen as they are recorded.  
 
You can thus trace the deployment of the probe, from the hole collar to the end of the hole, and see any deviation 
in the borehole.  
 
If the Boretrak2 probe has lost Bluetooth connection with the tablet during a deployment, then any Boretrak readings 
that have been recorded are shown as flashing yellow. This indicates that the displayed data is provisional and 
must be updated by downloading the data recorded in the probe. 
 
If the data has been downloaded, or if it was recorded with a live Bluetooth connection between the probe and the 
tablet, the Deployment is displayed a series of grey, 1 m sections. 

Station 

Deployment 

Bounding 
box 

Planned hole 

Figure 92 Stations and associated features displayed in the 3D View 



 

BT2 user manual - H-5911-9004-03-A   P a g e  | 90 

 
The Deployment Details window shows further information about the deployment (see section 14.3.1). 
 
The Project tab contains controls to turn deployments on and off in the 3D View window (see section 14). 

12.1.6 Bounding box 

A bounding box appears around the active station or deployment. The bounding box shows the geographic limits 
of the data.  
 
Which dataset is ‘active’ at any given time is determined by: 

• The deployment which is currently in progress. 

• Tapping on an item in the 3D View. 

• Selecting an entity in the Project tab. 

12.1.7 Imported data 

Any pre-existing data imported into the project can be viewed alongside data generated by the Boretrak2 within a 
project. 
 
The Project tab contains controls to turn imported data on and off in the 3D View window (see section 14.1.1). 

12.2 3D View tabs 

Two 3D Views can be open but only one is ‘active’ and displayed in the 3D View window at any time. Each 3D 
View is contained within a tab which is arranged, by default, along the left-hand side of the screen. For example, 
you may wish to have one view set as a top down, orthographic view, and another a perspective view for free 
rotation. 
 

 
The active 3D View tab is identified by a blue highlight. 
 
Tap the tab Delete 3D View button to delete a 3D View tab. 

3D View 3D View tab 

Active 3D 
View tab 

Delete 3D 
View button 

Figure 93 3D View tabs 
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12.3 View buttons 

Buttons along the bottom of the 3D View window provide options for viewing data. 
 

 
These buttons are described below. 

12.3.1 Vertical and horizontal compass 

The vertical compass and horizontal compass are side bars in the 3D View which can be give a live readout of the 
direction and inclination in which you are viewing the data. Tap Vertical and horizonal compass to open a dialog.  
 

 
Use the Vertical Compass and Horizontal Compass switches to turn on the side bars in the 3D View. If one of 
the compasses is switched on, the Vertical and horizonal compass button moves to the top right of the 3D View. 

 
 

12.3.2 View control 

The View control provides pre-defined view of all data currently active in the 3D View. To zoom to pre-defined views 
of specific scans, deployments, or stations, use other zoom buttons in the Control tab or in the Project tab. 

Vertical and 
Horizontal compass 

View control 

Drag 
function 

Figure 94 3D View buttons 

Figure 95 Vertical and horizontal compass dialog 
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Vertical 
compass 

Horizontal 
compass 

Figure 96 Vertical and Horizontal compasses switched on 
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Tap View to open the View dialog. 
 

 
A choice of Perspective or Orthographic view is available.  

• In Perspective view, the data can be freely rotated. Objects which are far away are smaller than those 
nearby. A perspective viewpoint gives more information about relative distances and is often easier to view 
as it is familiar from our real-life view of the world. 

• In Orthographic view, the data is viewed from a fixed perspective. All edges perpendicular to the view 
direction appear in proportion, at the same scale. Uniform perspective is particularly useful when analysing 
data to see the floor level or the shape of a void from fixed viewpoints. 

You cannot rotate data when Orthographic view is selected. The default rotating action will pan the data 
instead. 

 
When the Orthographic view is selected, gridlines are projected onto the 3D View. The Vertical Ruler and 
Horizontal Ruler are displayed along the side and top of the screen, respectively.  
 
An Orthographic options button appears in the top left of the 3D View. Tap the Orthographic options 
button to open the Orthographic options dialog. 
 

 

o Show Grid: toggles the background grid off and on. 

Figure 97 View dialog 
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Figure 98 Orthographic view options 
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o Lock Grid: holds the grid squares constant as you zoom in and out of the 3D View. With Lock 
Grid switched off, the grid resizes depending on the zoom level.  

o Vertical Ruler: shows a bar along the side of the 3D View. This displays grid coordinates if you 
are viewing from the top of the data, or the height if you are using a side view. 

o Horizontal Ruler: shows a bar along the top of the 3D View which displays grid coordinates. 

 
The View dialog offers six pre-defined views: 

• Top 

• Bottom 

• Front 

• Back 

• Left 

• Right 

Tap a pre-defined view to all active data from this angle. If you are using Perspective view, you can immediately 
rotate the data from the selected, pre-defined view. 

12.3.3 Drag action 

Determines the effect of dragging your finger, stylus or mouse on the 3D View. 

• Orbit: rotates data in the 3D View. This is the default action when using Perspective view. 

• Pan: pans data in the 3D View. This is the default action when using Orthographic view. 

• Look: sets the centre of rotation to be your current viewpoint, so you can look around the scene from a 
fixed location. 

• Zoom: zooms in when you drag up the screen and zooms out when you drag down the screen. 

12.4 New 

Tap New to start a new Carlson Boretrak project. 
 
A message window opens: ‘Do you want to save changes? All unsaved edits will be lost’. 

• Tap Save to save all changes in your existing project and continue to create a new project. 

• Tap Discard to reject any changes in your existing project and continue to create a new project. 

• Tap Cancel to cancel the new project operation and remain in your current project. 

Tap Save or Discard and the Project Details window opens (see section 14.1). Enter the required details for your 
new project and tap Accept to create the project. 
 
To connect to a Boretrak2 probe, open the Control tab and click Find Boretraks (see section 15). 



 

BT2 user manual - H-5911-9004-03-A   P a g e  | 94 

12.5 Function tabs 

By default, on the right-hand side of the screen, are four function tabs which allow control of the Boretrak2 probe, 
provide data viewing and analysis tools, and enable management of the project. 
 

 
Tap the required tab to make it active. 
 
The active function tab is identified by a blue highlight. 
 
Tap the active function tab to retract it and switch the 3D View to a full screen display. 
 
The function tabs are each outlined in the following sections. 

• Menu tab: see section 13. 

• Project tab: see section 14. 

• Control tab: see section 15. 

• Measure tab. 

Function 
tabs 

Figure 99 Function tabs 
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13 Menu tab 

The Menu tab contains buttons which offer project level and software level functions. 
 

 

13.1 Open 

Tap Open to open an existing Carlson Boretrak project. An Open dialog appears.  
 
Select the appropriate project from the recent files list. Alternatively, tap Browse Files to open an Open File 
windows dialog. Browse to the project location and select the *.ndv file to open the project in Carlson Boretrak. 
 
On opening a project, you can reconnect to a scanner via the Find Scanner button on the Control tab (see section 
15) or through the Project Details window (see section 14.1). 

13.2 Import 

Tap Import to import other files into your active Carlson Boretrak project. These files may contain pre-existing 
data such as surveyed points, solids or linework. This data can be used as a backdrop to data collected with the 
Boretrak2.  
 
Currently supported file types are: 

• E57: Lidar point cloud data 

• LAS: LAS scan data file 

• LAZ: LAZ compressed scan data file 

• DXF: Autodesk DXF 

Figure 100 Menu tab 
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• DXF: Deswick DXF 

• DWG: AutoCAD drawing file 

• DRL: Carlson borehole data format 

• XML: LandXML 

• OMF: Open Mining Format 

• MDL: Carlson Model Format 

• NDV: Carlson Boretrak project. Merge data from an existing project with the data in your current project. 

• TIN: Carlson triangulation format 

• OBJ: Wavefront Object 

• PLY: Polygon library 

• STL: Stereolithography 

• DAE: Collada 

• CSV: Hole ASCII. Imports hole collar information in a user-defined ASCII format. 

• *.*: Hole ASCII. Import hole collar information in a user-defined ASCII format. 

• *.* Point ASCII. Import survey points in a user-defined ASCII format. 

13.3 Save 

Tap Save to save all changes in your existing Carlson Boretrak project. 
 
Note that a backup project is continually saved in the Backup sub-directory in the project folder (see section 11.3.1). 
 
If you have not yet manually saved a project, the project is automatically saved in the _Unsaved Projects folder 
(see section 9.5). 

13.4 Save As 

Tap Save As to save the project under a different name or in a different location on your tablet. 

13.5 Export 

Tap Export to export data from the active project. A file dialog opens. Select the location where you wish to save 
the data, the file name and the file type. 
 
Tap Save. Depending on the file type selected, an appropriate export dialog opens. Confirm the specific data within 
the project that you wish to export and configure any export options as required. 
 
After accepting all settings, tap Export to generate the export. 
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13.6 Browse 

Tap Browse to open Windows File Explorer at the location where the active project is stored (see section 11.3.1). 

13.7 Alignments 

Tap Alignments to open the Alignments window. All alignments in a project are listed and can be examined and 
edited (see section 14.1.4). 

13.8 Holes 

Tap Holes to open the Holes window. All holes in a project are listed and can be examined and edited (see section 
14.1.2). 

13.9 Project 

Tap Project to open the Project Details window. The Project Details window contains information about the 
project, holes, deployments and alignments that have been carried out within the current project (see section 14.1). 
 

13.10 Reports 

Tap Print to print out the views in all 3D View tabs. A Print window opens. 
 
Configure any print settings and tap Print to print the views to file or to a printer. 

13.11 Light / Dark 

Tap Dark / Light / Black to toggle between the two themes. During in-field operations, whether it be underground 
or in bright sunlight, one or other of the themes may give a clearer view of the screen. 
 
You may also need to change the background colour to improve visibility in certain lighting conditions (see section 
4.4.4). 

13.12 Settings 

Tap Settings to view or edit software configuration settings. The Settings window appears (see section 11.3). 

13.13 About 

Tap About to access help documentation and program information (see section 11.4).  
 
The version number of the software is shown in the About screen and should be quoted during any support call 
with Carlson. 
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13.14 Exit 

Tap Exit to exit Carlson Boretrak. 
 
A message window opens: ‘Do you want to save changes? All unsaved edits will be lost’. 

• Tap Save to save all changes in your existing project and exit Carlson Boretrak. 

• Tap Discard to reject any changes in your existing project and exit Carlson Boretrak. 

• Tap Cancel to cancel the new project operation and remain in your current project. 
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14 Project tab 

The Project tab contains a record of all data collected or imported within the active Carlson Boretrak project. 
 

 
The list of elements in the Project tab expand indefinitely as more stations are added, scans are recorded, and 
data imported.  
 
Each element in the Project tab (other than the project itself at the top of the Project tab) can be selected and 
acted upon using buttons which appear directly underneath the element. 
 

 
The buttons which appear are: 

• Details: opens a relevant window or tab, which shows information about the selected element and, where 
appropriate, offers functionality to configure or analyse the element. 

• Visible / invisible: toggles the selected element, and all elements nested beneath it in the Project tab, on 
and off in the 3D View. 

• Zoom: zooms in to the extents of the selected element, and all elements nested beneath it in the Project 
tab. Use the drop-down list to select a pre-set view: 

o Top 

o Bottom 

o Front 

Figure 101 Project tab 

Figure 102 Details, Visible/Invisible, Zoom and Export buttons 
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o Back 

o Left 

o Right 

• Export: exports the selected element and, by default, all elements nested beneath it in the Project tab. 
Individual elements can be switched on or off during the export process. 

Each element in the Project tab (other than the project itself at the top of the Project tab) has a context menu, 
accessed by right-clicking the element. 
  

 
The context menu items differ slightly depending on the element selected, but all context menus include: 

• Export: export the selected element and each element underneath it in the project tab. 

• Hide / Make visible: toggle the selected element visible / invisible in the 3D View. All items directly under 
the selected element are also made visible / invisible. 

• Delete: delete the selected element. All items directly under the selected element will also be deleted. 

• Hide everything else: leaves only the selected element, and all items directly underneath it, visible in the 
3D View. 

• Deploy here: begins a Boretrak deployment from the selected element.  

 
The list of items that may appear in the Project tab are listed below. 

14.1 Project 

At the top of the Project tab is the Project element.  
 

Project 
element 

Project 
Details 
button 

Figure 104 Project element 

Figure 103 Project tab context menu 
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Tap the Project Details button to open the Project Details window. 
  

 
The Project Details window contains tabs. 

14.1.1 Project tab 

Enter into the Project tab details of the project. 

• Directory: displays the current location of the project. If required, edit the directory path in the text entry 
box, or tap the Browse button to the right to select a different address in which to save the project.  

• Project Name: displays the name of the project. If required, edit the project name in the text entry box. The 
project name will also be the name of the *.NDV project file and the project directory. 

• Surveyor: enter the name of the surveyor responsible for the project. 

• Notes: enter any project notes.  

14.1.2 Holes tab 

The Holes tab provides tools for managing the holes in the project.  

Figure 105 Project Details > Project 
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A Hole defines the position of the hole collar. The XY coordinates of the hole should mark the point on the collar 
where the probe is deployed. The Z value should mark the elevation to which each deployment interval is measured. 
 
A list of all holes in the active project is displayed. The list shows the station name followed by the station coordinates 
and a Deploy button. 
 
To edit a hole in the list, tap on the appropriate hole to open the Hole Details window (see section 14.2.1).  
 
To start a survey from a specific hole, tap the Deploy BT button next to the appropriate station.  
 
In the 3D View, the location of these coordinates is marked by a hole graphic. 
 
Tap Import to add holes from a file to the project. The file may be a Carlson *.DRL file, or a *.CSV text file. The text 
file may contain hole name, row name, coordinates, hole names and reference headings. Navigate to the 
appropriate location and select a file. The Hole ASCII Import Properties window opens. Define the columns in the 
file and tap Import. The holes are added to the list in the Project window > Hole tab. 
 
Tap Add Hole to manually add a single hole to the project. The Hole Details window appears (see section 14.2.1). 
Enter the hole parameters as required. 
 
Tap Add Pattern to add a pattern of holes to the project. The Pattern window opens. 

Figure 106 Project Details > Holes 
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Configure details of your desired hole pattern: 

• Hole count: number of holes per row 

• Row count: number of rows 

• Hole spacing: measurement along the row between holes 

• Row spacing: measurement between each row 

• Row offset: 

o Aligned: holes in a row are aligned with holes in the next row 

o Staggered: holes in each alternate row are offset with respect to the next row 

o Skew: holes in each row are offset with respect to the next row in an accumulating fashion. Enter 
an offset distance in the text entry box. 

• Hole name format: select how each hole in the pattern should be named 

• Row name format: select how each row should be named 

• Location offset: the coordinates of the first hole in the first row 

• Tilt: the slope angle along each row 

• Row azimuth: the heading of all rows, measured from hole 01 to subsequent holes 

Tap Create to create the hole pattern. 
 

Figure 107 Pattern window 
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A Pattern element is added in the Project tab. Under the Pattern are Row elements, and under each Row are the 
Holes. 
 
Tap the Pattern Details button to access the Pattern window for further editing of the layout of the rows and holes. 

14.1.3 Deployments tab 

The Deployments tab lists the Boretrak2 deployments which have been carried out in the active project.  
  

 
A list of all deployments in the active project is displayed. Each row in the list of deployments displays the Hole from 
which the deployment was made, the Name of the deployment and the, the coordinates of the end of the 
deployment. 
 
Tap on a deployment to open the appropriate Deployment Details window (see section 14.1.3). 
 
If data is missing from any of the deployments, tap the Find Missing Records button. Carlson Boretrak trawls 
through unutilised records that have been downloaded from a Boretrak2 and analyses whether they match up with 
the missing records in the listed deployments. 
 
In the 3D View, the deployment is marked by a deployment graphic (see section 12.1). 

Figure 109 Project Details > Deployments 

Figure 108 A hole pattern in the 3D view and Project tab 
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14.1.4 Alignment tab 

The Alignments tab lists the Boretrak2 alignments which have been carried out in the active project.  
 

 
An Alignment marks an alignment event carried out during field operations. 
 
The list shows the Name of the alignment, followed by the Azimuth that has been manually input or computed. 
 
To edit an alignment in the list, tap on the appropriate alignment to open the Alignment Details window. Edit the 
details as required.  
 

 
Note that if the heading is edited, all data collected using the selected alignment will be affected by this edit. Each 
deployment will rotate around its collar position by the number of degrees by which the heading has changed. 

14.1.5 Layers tab 

The Layer controls provide tools to manage the layers into which the data in the 3D View is divided. 

Figure 110 Project Details > Alignments 

Figure 111 Alignment Details 
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Layers are created for text, for each alignment, deployments, planned holes and for imported datasets.  

• Tick or untick the Visible check box to turn the layer on or off in the 3D View. 

• The display options of each layer can be changed in the Layers tab. Select a colouring option from the 
Display Settings drop down list. This selection overrides any colour settings for individual entities within 
the layer.  

• Restore settings for individual entities within a layer by selecting the blank entry from the Display Settings 
drop down list. 

14.2 Hole 

Each Hole in a project has its own element in the Project tab. There may be multiple Holes in a Project and they 
may be setup in advance of field operations. 
 

 
The Hole may have one Planned and one or more Deployment elements nested beneath it.  

• The Hole Visible / invisible button toggles all these elements on and off in the 3D View. 

• The Hole Zoom button positions the extents of all these elements within the 3D View. 

• The Hole Export button exports data from all these elements. 

Tap the Hole Details button to open the Hole Details window. The Hole Details window has four tabs, described 
below. 

Figure 112 Project Details window > Layers tab 

Hole 
element 

Figure 113 Hole element 
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14.2.1 Hole Setup tab 

The Hole Setup tab provides controls to configure the hole. 
 

 
Enter a name for the hole in the Hole text field. 
 
Enter the collar coordinates in the Survey Point text fields. 
 
The Planned frame enables the setup of planned or ‘design’ hole properties. A surveyed deployment can be 
compared with the planned hole to establish the deviation along the length of the surveyed hole. 
 
One Planned hole can be set up for each Hole in a project. The settings are mirrored in the Deployment Details 
window > Planned tab (see section 14.3.1). 
 
The Planned hole can be set up using manually entered angles, or by entering coordinates for the end of the hole. 
Use the radio buttons to select between these options. 

• None: no Planned Hole is attached to the selected Hole. 

• Angles: enter a Depth, a Heading angle, and an Incline angle to establish the Planned Hole. 

• Target: enter the X,Y,Z coordinates of the end of the hole to establish the Planned Hole. The Depth is 
adjusted automatically. 

To use the same planned hole values for holes which are created subsequently within the active project, tap Make 
this default. If a new hole is created, these planned hole values are applied when the Angles or Target radio 
buttons are selected. 
 
To apply the same planned hole values to all holes which already exist in the active project, tap Apply to existing 
holes. 
 

Figure 114 Hole > Hole Setup 
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14.2.2 Deployments tab 

The Deployments tab lists the Boretrak2 deployments which have been carried out from the selected hole. 
 

 
A list of all deployments made from the selected Hole are displayed. Each row in the list of deployments displays 
the Name of the deployment and the coordinates of the end of the deployment. 
 
To view details of a deployment in the list, tap on the appropriate deployment to open the Deployment Details 
window (see section 14.1.3). 

14.3 Deployment 

Each Deployment in a project has its own element in the Project tab. There may be multiple deployments 
underneath a single Hole.  

• The Deployment Visible / invisible button toggles all these elements on and off in the 3D View.  

• The Deployment Zoom button positions the extents of all these elements within the 3D View.  

• The Deployment Export button exports data from all these elements. 

Note that the Deployment element in the Project tab is shown as a warning icon until all data from that deployment 
has been downloaded. Data from any deployment should not be accepted until the warning icon has changed to 
the standard Deployment icon. 
 

 
Tap the Deployment Details button to open the Deployment Details window. 

14.3.1 Deployment Details 

The Deployment Details window outlines results from the selected deployment. 

Figure 115 Hole > Deployments 

Figure 116 Deployment icon before all data is downloaded (left) and after download (right) 
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Results tab 

The Results tab displays a table containing details of each Boretrak reading that was taken during the selected 
deployment. One row represents one reading. Columns in the table display: 

• Downloaded: A blue tick indicates that this reading has been successfully downloaded. A download symbol 
indicates that the data is provisional and that the download has not yet occurred. 

• Az: recorded azimuth / heading of the Boretrak2 probe 

• Inc: recorded inclination of the probe. 

• Length: distance travelled along the hole, as measured using the Segment Length (see section 15.4) and 
the number of readings taken. The last reading also takes the Offset value into account (see section 5.6). 

• Dev: the deviation of the Deployment from the Planned Hole. This is a horizontal straight-line distance 
between the two. Only shown if there is a Planned hole associated with this Hole. 

• Time: the time at which the reading was taken. 

• Elevation: the absolute Z value of the reading, computed from the starting collar position.  

Figure 117 Deployment > Results 
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• Edit: tap the Edit button to edit the reading. The Edit Segment window appears. Use these controls with 
caution as they allow the editing of surveyed data. 

 

 

o Length: edit the length of the segment. 

o Roll, Pitch, Azimuth: edit the orientation of the segment. 

o Straighten: if there is an obvious kink in the hole then this control can be used to smooth the path 
of the deployment. This may have occurred due to irregularities along the side of the hole, or due 
to readings being taken while the probe was still moving. The heading and inclination of the selected 
reading is adjusted with reference to the adjacent reading(s) to smooth the path of the deployment. 

o Delete: click to delete the selected reading. You may know that an additional reading was taken 
accidently and that it must be deleted. 

Tap Done to register the edits. Note that subsequent segments in the deployment will shift so that they 
remain connected to the selected segment. 

Editor tab 

The Editor tab provides controls which allow editing of the Deployment. Use these controls with caution. 

Figure 118 Edit Segment window 
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• Segments: these controls concern the deployment intervals used during the deployment. 

o Segment Length: edit the deployment interval that was used for the deployment. 

o Final Offset: edit the offset that was entered after the last reading taken during the deployment. 

• Planned deployment: adjust the parameters of the Planned hole (see section 14.2.1). 

Visuals tab 

The Visuals tab contains controls which change the appearance of the Deployment in the 3D View. 
 

 

Figure 119 Deployment Details > Editor tab 

Figure 120 Deployment Details > Visuals tab 
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• Deployment Layer Colour: select the method by which the deployment is coloured. Three colours can be 
defined with values related to the selected method. 

• Type: select the graphical appearance of the selected deployment: 

o Hidden: hides the deployment. 

o Model: displays the deployment as a series of 1 m rods. 

o Polyline: displays the deployment as a polyline. 

o Tube: displays the deployment as a tube with a user-defined diameter. 

2D Views 

The 2D Views show graphical views of the Deployment, together with the associated Planned Hole. 
 

 

• Plan View: shows a plan view of the deployment against a radial plot centred on the hole collar.  

• Front View: shows a side view of the deployment. With Heading: Hole Azimuth selected, the Front View 
displays a perspective along the heading of the deployment – ie the deployment hole is heading directly 
into the screen. With Heading: North/East selected, the view is looking North.  

A Lock Axis button toggles the Y axis scale to be the same as that of the X axis, or to be ‘best fit’ for the 
space. 

• Side View: shows a view from a perspective perpendicular to that of the Front View. 

Figure 121 2D Views: Plan View (left) and Side View (right) 
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15 Control tab 

The Control tab provides direct control of the connected Boretrak2 probe. This section outlines the Control tab 
functions and layout when aBoretrak2 is connected and a deployment is being prepared or is in progress.  

15.1 Connection to a Boretrak2 

15.1.1 Autodetect routine 

Carlson Boretrak has an autodetect routine to establish if there are any Boretrak2 probes visible to the tablet’s 
Bluetooth. Any probe which is powered on and paired with the tablet is detected.  
 
The autodetect routine can be started automatically by tapping New from the Touch mode Home screen and 
creating a project. 
 
Alternatively, if you open an existing project and want to connect to a Boretrak2 probe, tap the Find Boretraks 
button in the Control tab to initiate the autodetect routine.  
 
The Find Boretraks button is present on the Control tab in the following situations: 

• If you have opened Carlson Boretrak in Desktop mode. Click New to start a new project. Enter any 
required details in the Project Details window and tap Accept. 

• If you have opened an existing project and are viewing data without a connection to a scanner. 

• If you are in an existing project and have lost connection with a scanner or have tapped the Disconnect 
Device button. 

Once the autodetect routine has been initiated, Carlson Boretrak searches through all available Bluetooth 
connections for any Boretrak2 probe which has been paired with the tablet. 
  

 
If no connection is made, check: 

• The Boretrak2 probe is powered ON and flashing red or blue. 

• The Boretrak2 is paired to your device. 

• Bluetooth is switched ON on your device. 

• No other devices are connected to the same Boretrak2 probe. 

Tap Find Boretraks to reattempt a connection. 

Figure 122 Auto connection in progress 
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15.1.2 Connected 

On detection of a Boretrak2 probe, Carlson Boretrak runs through checks to establish that communications with 
the Boretrak2 are sound and to read information from the probe. 
 
With all checks complete, a graphic of the Boretrak2 probe appears in the 3D View attached to the default Hole.  
 
The Control tab becomes active, displaying deployment controls. These controls are outlined below. 
 

 

15.2 Probe status 

A series of icons displays the current probe status. The icons are rearranged depending on the current stage of the 
survey 
 
When Carlson Boretrak first connects to a probe, there four icons are displayed. 

 

Figure 123 Control tab - Boretrak2 probe just connected 

Probe 
details 

Temperature (some models of BT2 only) Battery 

LED light 
icon 

Figure 124 Probe status prior to an alignment being carried out. 
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15.2.1 Probe Details icon 

Tap the Probe Details icon to access technical data about your Boretrak2 probe. If you contact Carlson for support, 
you may be asked to access this page. 

15.2.2 Temperature icon 

Tap the Temperature icon to view the current probe temperature. The icon is green while the Boretrak2 probe is 
operating within its temperature limits. This icon does not appear when connected to some models of BT2. 

15.2.3 Battery 

Tap the Battery icon to view the current battery status. The icon is green while the Boretrak2 probe’s batteries are 
operating within their voltage limits.  

15.2.4 LED light icon 

The LED light icon reflects the colour of the LED light on the Boretrak2 probe. The LED light icon should be green 
before you start a deployment. 
 
Note that when the probe is deployed, the Bluetooth connection between the probe and the tablet is usually lost. In 
this case the LED light icon is not updated unit this connection is re-established. 

15.2.5 Reconnect button 

The Reconnect button appears if Carlson Boretrak loses connection with the Boretrak2 probe. This happens by 
default once a deployment has started. It may also happen if the battery is exhausted. 
 
Tap Disconnect to manually disconnect from the probe. This control now becomes the Reconnect button. 
 
During normal operations when the probe is deployed down a borehole, the probe will usually lose connection. 
When the probe is recovered and is within range of the tablet, the Bluetooth link is automatically re-established. If 
this fails to happen, tap Reconnect to manually reconnect the tablet with the probe. 

15.2.6 Alignment icon 

The Alignment icon appears only when the Boretrak2 probe is aligned, and logging has been started. Tap on the 
icon to realign the probe or to verify the current alignment. 
 

Reconnect 
button 

Figure 125 Probe status when alignment has been lost 

Alignment icon 

Figure 126 Probe status while the probe is aligned 
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Tap on the icon. The green Alignment button appears. 
 
Tap the Alignment button. The Alignment Options dialog opens. 
 

 
The time since the last alignment is displayed. 

• Tap New to carry out another alignment. Return the probe to the alignment jig before proceeding. You may 
wish to carry out a new alignment regularly after each hole, or after every few holes, depending on the 
length of the holes and the time taken. 

• Tap Verify to check how much the gyro has drifted since the last alignment. To verify the alignment, the 
alignment jig must be unmoved since the previous alignment was taken.  

 

 
Place the probe back on the jig, in the same orientation. The jig must not have been moved since the last 
alignment. 
 
Tap OK. The current heading is compared to the user-defined alignment heading from the last alignment. 

 

• Tap Edit to change the name or heading of the current alignment. The Alignment window appears (see 
section 15.5.1). Edit the details of the current alignment as required. 

Figure 127 Alignment options 

Figure 128 Verify Alignment 

Figure 129 Alignment Drift 



 

BT2 user manual - H-5911-9004-03-A   P a g e  | 117 

 

15.3 Hole controls 

 

15.3.1 Hole drop down 

The active hole is displayed in the Hole drop-down list.  
 
Tap the Hole drop-down list to see all holes in the active project. From the list, tap New Hole to create a new hole 
within the current project. The Hole Details window appears from where you can configure the new hole (see 
section 14.2.1). 

15.3.2 Hole details 

Tap the Hole Details button to open the Hole Details window. Edit details of the active hole including name, 
coordinates and view options (see section 14.2). 

15.3.3 Zoom to hole 

Tap the Zoom button to zoom to a view of the active hole and all data that has been collected from that hole. Tap 
the Zoom drop-down list to access pre-defined views of the hole. 

15.4 Segment length 

During deployments, the Boretrak2 probe is lowered at fixed intervals. At each interval, the probe is held steady 
while a Boretrak reading is taken. Use the Segment length drop-down to define this deployment increment. 
 

 
In the drop-down list are three options  

• 1 m. 

• 2 m: this is the default for the first reading taken in a deployment. 

• Custom: this activates the number-pad so that you can enter a user-defined distance. 

The selected option cannot be changed after a deployment has been started. 

Zoom to 
hole 

Station 
drop-down 

list 

Hole details 

Figure 130 Hole Controls 

Figure 131 Segment length 
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15.5 Gyro Controls 

The Gyro controls enable you to control the alignment of the gyro.  
 

 
The probe uses a gyro – contained within an IMU - to navigate during a deployment. An alignment is required to 
initialise the gyro heading. 

15.5.1 Align Gyro button 

The gyro requires alignment before you can proceed. Press the Align Gyro button to carry out the gyro alignment.  
 
Note that during this stage, the probe must be absolutely stable and free from movement and vibration. The probe 
must also be positioned in a known heading. The alignment jig is supplied with a Boretrak2 system to stabilise the 
probe and provide a baseline for the heading to be established. 
 
The alignment takes approximately three seconds. 
 
A message appears: “Are you sure you want to align the Gyro?”. Tap Yes. 

 
The Alignment window appears. 

 

 
To name the alignment, enter a name in the Alignment ID text field. By default the name is Alignment hh:mm. 
 
The heading of the alignment jig can be entered in the Azimuth frame. Note that the different methods listed under 
Azimuth are determined by the configuration of settings in the Settings window > Hole tab (see section 11.3.8). 
Some methods may be disabled if they are considered redundant for your operations. 
 
The available methods are listed below. 

• None: a default value of 0.00 degrees is used for the heading. 

Figure 133 Alignment window 

Figure 132 Align Gyro button 



 

BT2 user manual - H-5911-9004-03-A   P a g e  | 119 

• Heading: If you have surveyed in the alignment jig and computed a heading, select the Heading radio 
button and enter the surveyed value. 

• Back Point: manually enter a ‘back point’ coordinate. A heading is computed from the back point to the 
hole collar.  

• Two Point: manually enter a back point and a front location. A heading is computed from the back point to 
the front location.  

• Relative: If you have lined up the alignment jig between two holes which have been defined in your project, 
select the Relative radio button. Select two hole collars from a To and a From drop down list. A heading is 
computed between the two locations. 

• Use Existing: select a previously used alignment from a drop down list. The heading is copied from the 
selected alignment. 

Tap Close to close the Alignment window. 
 
The Align Gyro button changes to yellow while it is aligning, then to green when it has aligned.  
 

 
Shortly after the gyro has aligned, the Gyro Align button disappears and an Alignment icon appears at the top of 
the Control tab (see section 15.2.6). The gyro is aligned and functional.  
 
 

 
Note that if, during the survey, the probe is moved beyond the limitations of the gyro (i.e. a faster than the 
960°/second maximum rotation rate) then an error message appears. The Alignment icon turns red and the gyro 
must be realigned on the alignment jig. 
 

 
Note that this error can only be registered by Carlson Boretrak while the Boretrak2 probe and tablet have a live 

Figure 134 Gyro - aligning 

Figure 135 Gyro exceeded rotational limit message 

Alignment  icon 
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Bluetooth communications link established. If the rotation limit is exceeded while the probe is out of Bluetooth range 
of the device, then the message appears as soon as the Bluetooth connection is restored.  
 
Any data collected since the alignment was lost will be unreliable. Therefore, whenever this message appears, you 
should realign the probe and repeat the survey of the hole(s) surveyed since the alignment was lost. 
 
Throughout a Gyro deployment, the HDG value shown in the Live display (see section 15.6) is taken directly from 
the gyro. The reference ‘0.0°’ heading for any survey is based on the initial alignment.  
 
Full details of the Boretrak2 operations and procedures are outlined in section 5. 
 
With the alignment complete, the Deployment controls appear. 
 

 

15.5.2 Realign / check alignment 

While the gyro is aligned, the Alignment icon is displayed in the top right of the Control tab. Tap the Alignment 
icon to realign, or to check the alignment. 
 
An Alignments Options dialog opens.  
 

 
Figure 137 Alignment Options 

Figure 136 Control tab after aligning the gyro, before the first reading has been taken 
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• Tap New to carry out another alignment. Return the probe to the alignment jig before proceeding. You may 
wish to carry out a new alignment regularly after each hole, or after every few holes, depending on the 
length of the holes and the time taken. 

• Tap Verify to check how much the gyro has drifted since the last alignment. To verify the alignment, the 
alignment jig must be unmoved since the previous alignment was taken.  

 

 
Place the probe back on the jig, in the same orientation. The jig must not have been moved since the last 
alignment. 
 
Tap OK. The current heading is compared to the user-defined alignment heading from the last alignment. 

 

• Tap Edit to change the name or heading of the current alignment. The Alignment window appears (see 
section 15.5.1). Edit the details of the current alignment as required. 

15.6 Live display 

The Live display shows data from the probe’s sensors and from the deployment. 
 

 
After the gyro is first aligned, the heading and inclination are displayed. 

• Heading: shows the probe’s live heading. This is the direction the probe is pointing when seen from above. 

Figure 138 Verify Alignment 

Figure 139 Alignment Drift 

Figure 140 Live display after first aligning the gyro 
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The heading is defined by the initial alignment. 

• Inclination: the inclination of the probe with respect to gravity. 

Live data from the gyro can only be displayed while Carlson Boretrak is connected to the Boretrak2. After the first 
reading is taken, they are disconnected. Thereafter, the live display shows the deployment status.  
 

 

• Segments: the total number of readings taken, irrespective of the Segment Length set for each reading. 

• Length: shows the distance the probe has been deployed from the collar during the active deployment. 
This value is computed by multiplying the number of readings taken by the Segment Length selected. 

Note that the counting of the segments is a purely manual exercise: if you mistakenly forget to take a reading 
or take multiple readings at any stage of the deployment, then the Length will be incorrect. 

15.7 Logging  

With the gyro aligned, the Boretrak2 probe automatically starts logging data. 
 
While there is a live Bluetooth connection, data is ‘silently’ downloaded from the probe to the tablet, approximately 
every thirty seconds.  
 
When the Bluetooth connection is not live, the probe stores all logged data internally. When the Bluetooth link is 
then re-established, the probe downloads all stored data to your tablet. If the Bluetooth link has been down for a 
long period of time, there may be a substantial amount of data to download. In this case you may see a 
Downloading data message. Thereafter, while the Bluetooth connection is live the regular short downloads will 
continue. 

15.8 Deployment controls 

When the Boretrak2 probe is deployed by the amount selected in the Segment length drop down list, tap Take 
Reading to take the first reading along the hole. 
 
After the first reading the Final Reading and Undo Last buttons are active. 
 

Figure 141 Live display after the first reading 
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Continue the deployment. At each stage: 

• lower the probe by the selected increment  

• hold the probe steady 

• tap Take Reading to register that the probe has been dpeloyed by the Segment length distance 

• hold the probe steady while the Hold still message is showing. 

• Tap Undo Last to remove a Boretrak reading that has been taken mistakenly. 

When you feel the Boretrak2 probe touch the end of the borehole, keep the steel cable tight so that the probe 
remains upright with respect to the hole.  
 
Tap Final Reading to take the final reading in the borehole. 

15.9 Final offset controls 

After the Final Reading button has been tapped, the Final Offset controls appear. 
 

Figure 142 Control tab after the first reading has been taken 



 

BT2 user manual - H-5911-9004-03-A   P a g e  | 124 

 

15.9.1 Final offset 

Commonly, when the probe reaches the end of the hole, the last deployment interval does not equal the full, user-
defined Segment Length (see section 15.4).  
 

 

Figure 143 Final Offset controls 

Hole collar 

The next nodule that 
would have been used in 
the deployment 

Final offset 

Figure 144 Final offset measurement 
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In this case, while the probe is at the end of the hole and the cable is kept taught, measure the distance from the 
hole collar back along the cable to the next measurement point, i.e. the next interval / nodule / rod joint to which you 
would deploy if the hole were longer. Enter this value into the Final Offset field. This value is deducted from the 
last reading’s full segment length. 

15.9.2 Undo 

Tap Undo to return to the deployment. This may be required if you accidently tapped Final Reading during a 
deployment. 

15.9.3 Finish 

When the Final Offset is entered, tap Finish to complete the deployment.  
 
Retrieve the probe from the borehole. Carlson Boretrak attempts to reconnect to the probe. As soon as the 
connection is established, data is automatically downloaded from the probe to your device. 

15.10 Next Deployment controls 

The Next Deployment controls appear when a deployment is completed. 
 

 

15.10.1 Records downloaded 

A message shows that data is downloading, or that it has been downloaded. 

15.10.2 Select Next Deployment 

Select the next hole to survey. By default, the listed hole is the next hole sequentially within the project. To select a 
different hole, use the Select Next Deployment drop-down list to select the required hole. 
 
Use the Next and Previous arrows to progress to an adjacent hole or select a hole from the drop-down list. 

Figure 145 Next Deployment controls 
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15.10.3 Deploy to… 

To begin the deployment to the selected hole, tap Deploy to… 

15.10.4 New Alignment 

While you are between holes, consider carrying out a new alignment of the gyro. See section 15.5.2. 



 

BT2 user manual - H-5911-9004-03-A   P a g e  | 127 

16 Desktop mode 

When a project has been completed, the data is usually viewed and analysed back in the office. In this case, if you 
are using a larger format laptop or desktop computer then select Desktop mode. 
 
Desktop mode has a more traditional interface and is intended for use with a standard keyboard and mouse. 
 

 

 
All the same functionality is present in the Desktop mode, although the UI is arranged slightly differently.. 

16.1 Menu bars 

The controls in Desktop mode are arranged into buttons in the menu bars. There are three menu bars which can 
be selected by clicking the menu bar tabs. 
 

 

Figure 146 Desktop mode 

Menu bar tabs 

Undo / Redo buttons 

Layer controls 

Figure 147 Home menu bar 
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16.2 Home 

The Home menu bar includes all the controls which are present in the Menu tab in Touch mode (see section 13). 
In addition to these controls are: 
 

 

• Touch button: A Touch button is available when first starting the software. The option to swap modes is 
only available prior to opening an existing project or starting a new project. Once a session has begun, to 
swap modes, close the software down and reopen to access the relevant button.  

 

 

• Panel button: changes the arrangement of 3D View windows in the interface. Click the panel button to be 
offered a choice of: 

o 1 Panel 

o 2 Panel 

o 3 Panel left 

o 3 Panel right 

o 4 Panel 

 

 

• Log button: access detailed logs for troubleshooting and support purposes. 

 

• Undo / redo: after any editing or deleting data in the current project, undo or redo individual operations or 
a sequence of operations. 

16.3 Layer controls 

The Layer controls provide tools to manage the layers into which the data in the 3D View is divided. 
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Layers are created for text, for each alignment, deployments, planned holes and for imported datasets.  
 
Tap List to open the Layer tab in the Project window (see section 14.1.5). Alternatively, the same operations can 
be carried out from the toolbar: 

• Use the Current Layer drop down to select a layer 

• Toggle the Visible / Invisible button to turn the layer ON or OFF in the 3D View.  

• Select a colouring option from the Display Settings drop down 

Layer controls 
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17 Android version 

This manual has focused on the operation of Carlson Boretrak software on a windows tablet. As noted, a version 
of the software is also available for Android mobile devices. 
 
The interface and operation are almost identical and projects created in one version can be transferred and worked 
on in the other version. 
 
A few minor differences are outlined below. 

17.1 Storage 

The default storage location for projects is in Device/Documents/Carlson Boretrak. 

17.2 Screen size 

Android mobile devices are extremely diverse in terms of their screen size. Customise the Carlson Boretrak user 
interface for your specific device, using Settings > Interface > Scale. Change the UI and Text scales to optimise 
the use of screen space on your device. 

17.3 Screen layout 

The Carlson Boretrak interface auto-rotates along with the rest of the Android environment as the device is moved 
from portrait to landscape modes. 

17.3.1 Portrait mode 

In portrait mode, only one tab can be viewed at any one time. The 3D View appears as an additional tab (View) on 
the right-hand side of the screen. 
 

 
Figure 148 Portrait mode - Project screen (left), View screen (right) 
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The Menu, Project and Control tabs are the same as the Windows version. 

17.3.2 Landscape mode 

In landscape mode, the Carlson Boretrak interface has the same arrangement on an Android device as on a 
Windows tablet. 
 

 

17.4 3D View 

By default, navigation in the 3D View is conducted as follows: 

• Zoom in / out: pinch / expand gestures with two fingers; roll the scroll wheel on a mouse. 

• Rotate: drag with a finger; click and drag with a mouse. The centre of rotation is the point at which you first 
touch the screen to rotate. 

To ‘pan’ data in the 3D View, use the Drag action control. 
 

 
The Drag action control determines the effect of dragging your finger on the 3D View. 

• Orbit: rotates data in the 3D View. This is the default action when using Perspective view. 

• Pan: pans data in the 3D View. This is the default action when using Orthographic view. 

Figure 149 Landscape mode 

Figure 150 Drag action control 
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• Look: sets the centre of rotation to be your current viewpoint, so you can look around the scene from a 
fixed location. 

• Zoom: zooms in when you drag up the screen and zooms out when you drag down the screen. 

17.5 Sending projects 

If your Android device has Wi-Fi or cellular connectivity you can share a project via any means available to your 
device. 
 
From the Menu tab, select Send. 
 

 
Your device will offer all available methods of sharing the current project. These may include apps such as Android 
Beam, Gmail or Drive. Select the appropriate app to send the *.NDV file to a location or contact. 

Figure 151 Menu tab > Send icon 
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PRODUCT INFORMATION 



 

BT2 user manual - H-5911-9004-03-A   P a g e  | 134 

18 Product specifications 

Construction 

Probe Stainless steel 

Downhole cable 5mm plastic-coated steel cable with metre markers 

Push cable 9mm fibreglass rod with aluminium frame and reel 

Physical Weight Dimensions 

Probe  
(including batteries) 

3.1 kg 710 mm × 40 mm (Length × 
Diameter) 

System in case with 50 m steel 
cable and optional Android device 

13.3 kg 625 mm × 500 mm x 218 mm 

Sensors 

Build IMU with 3-axis gyro, accelerometer & magnetometer 

Deployment range (Basic) Downhole only: +/- 60° from vertically down 

Deployment range (Advanced) Full 360° range 

Gyro rotational limit Configurable: typically 960° per second 

Inclination accuracy +/- 0.1° 

System deployment accuracy* Final position to within 1% of hole depth 

Power 

Probe 3 × 1.5 V “D” cells (LR20) 

Environmental 

IP degree of protection (probe) IP68 (pressure rated to 30 bar, equivalent to 300 m water depth) 

Operating temperature (probe)** −10 °C to +60 °C 

Storage temperature (probe)** −20 °C to +70 °C 
 
*  Proved under Carlson test conditions. 
**The probe operating & storage temperature may be limited by the choice of battery. 
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19 System information 

© 2020 Carlson. All rights reserved. 
 
This document may not be copied or reproduced in whole or in part, or transferred to any other media or language, 
by any means, without the prior written permission of Carlson. 
 
The publication of material within this document does not imply freedom from the patent rights of Carlson. 

19.1.1 Trademarks 

CARLSON and the symbol used in the CARLSON logo are registered trademarks of Carlson in the United Kingdom 
and other countries. ‘Breaking new ground’ and names and designations of other Carlson products and technologies 
are trademarks of Carlson or its subsidiaries. 
 
The Bluetooth® word mark and logos are registered trademarks owned by the Bluetooth SIG, Inc. and any use of 
such marks by Carlson is under license. 
 
Android is a trademark of Google Inc. 
 
All other brand names and product names used in this document are trade names, trademarks, or registered 
trademarks of their respective owners. 

19.1.2 Changes to Carlson products 

Carlson reserves the right to improve, change or modify its products and documentation without incurring any 
obligation to make changes to equipment previously sold or distributed. 
 
Carlson has made considerable efforts to ensure the content of this document is correct at the date of publication 
but makes no warranties or representations regarding the contact. Carlson excludes liability, howsoever arising, for 
any inaccuracies in the document.  

19.1.3 Warranty 

Equipment requiring attention under warranty must be returned to your equipment supplier. 
 
Unless otherwise specifically agreed in writing between you and Carlson, if you purchased the equipment from a 
Carlson company, the warranty provisions contained in Carlson’s CONDITIONS OF SALE apply. You should 
consult these conditions to find out the details of your warranty but, in summary, the main exclusions from the 
warranty are if the equipment has been: 

• neglected, mishandled or inappropriately used, or 

• modified or altered in any way except with the prior written agreement of Carlson. 

If you purchased the equipment from any other supplier, you should contact them to find out what repairs are 
covered by their warranty. 

19.1.4 Safety 

The Boretrak2 is designed as a means of auditing the results of drilling activity quickly and accurately, for downhole 
and uphole use. The system is non-magnetic and therefore may be used in all types of rock, flooded holes and 
areas of ferrous materials and hole castings. It is essential that the unit and all accessories are operated in 
accordance with the instructions in this user manual and it is the responsibility of the user to ensure that, in the 
event of a failure of any part of the Carlson system, the equipment remains safe. 
 
In the case of equipment with powers or speeds capable of causing injury, it is essential that appropriate safety 
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protection measures are included in the machine usage. Further guidance can be found in BS EN ISO 12100:2010 
Safety of machinery – General principles for design – Risk assessment and risk reduction. 

19.1.5 Information to the equipment supplier/ installer 

It is the equipment supplier’s responsibility to ensure that the user is made aware of any hazards involved in any 
operations involving the Boretrak2 system, including those mentioned in Carlson product literature. 

19.1.6 EC declaration of conformity 

 
Carlson declares that the Boretrak2 complies with the applicable standards and regulations. 
 
Contact Carlson or visit www.carlsonsw.com for the full EC declaration of conformity. 

19.1.7 Radio-frequency disturbance characteristics 

As defined by BS EN 55011:2016 Industrial, scientific and medical equipment – Radio-frequency disturbance 
characteristics – Limits and methods of measurement, the Boretrak2 probe is defined as Group 1, Class A 
equipment. 
 
The Boretrak2 probe is suitable for use in all locations other than those allocated in residential environments and 
those directly connected to a low-voltage power supply network which supplies buildings used for domestic 
purposes. The Boretrak2 probe does not use radio- frequency energy for the treatment of material, for 
inspection/analysis purposes, or for transfer of electromagnetic energy. 

 
CAUTION: This equipment is not intended for use in residential environments and may not provide 
adequate protection to radio reception in such environments. 

19.1.8 FCC (USA only) 

19.1.9 Information to the user (47CFR section 15.19) 

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: 

1. This device may not cause harmful interference, and 

2. This device must accept any interference received, including interference that may cause undesired 
operation. 

19.1.10 Information to the user (47CFR section 15.21) 

The user is cautioned that any changes or modifications not expressly approved by Carlson or authorised 
representative could void the user’s authority to operate the equipment. 

19.1.11 Information to the user (47CFR section 15.105) 

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when 
the equipment is operated in a commercial environment. This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his own expense. 

http://www.carlsonsw.com/
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19.1.12 WEEE directive 

 
The use of this symbol on Carlson products and/or accompanying documentation indicates that the product should 
not be mixed with general household waste upon disposal. It is the responsibility of the end user to dispose of this 
product at a designated collection point for waste electrical and electronic equipment (WEEE) to enable reuse or 
recycling. Correct disposal of this product will help to save valuable resources and prevent potential negative effects 
on the environment. For more information, please contact your local waste disposal service or Carlson 
representative. 

19.1.13 Battery safety 

The Boretrak2 is supplied with non-rechargeable alkaline batteries (3 × Duracell LR20 1.5 V). The probe also 
contains a CR 2032 3 V 220 mAh lithium coin cell. The PDA contains a lithium polymer battery (4500 mAh). 

• Do not attempt to recharge the probe batteries. 

• Please dispose of waste batteries in accordance with your local environmental and safety laws. 

• Replace the batteries only with the specified type. 

• Ensure that all batteries are inserted with the correct polarity. 

• Do not store batteries in direct sunlight. 

• Do not heat or dispose of batteries in a fire. 

• Do not short-circuit or force discharge the batteries. 

• Do not introduce a metal connection between the batteries in the nose cone and the external metal housing. 

• Do not disassemble, pierce, deform or apply excessive pressure to the batteries. 

• Do not swallow the batteries. 

• Keep the batteries out of the reach of children. 

• Do not get batteries wet. 

• If a battery is damaged, exercise caution when handling it. 

19.1.14 Battery disposal 

 
The use of this symbol on the batteries, packaging or accompanying documents indicates that used batteries should 
not be mixed with general household waste. Please dispose of the used batteries at a designated collection point. 
This will prevent potential negative effects on the environment and human health which could otherwise arise from 
inappropriate waste handling. Please contact your local authority or waste disposal service concerning the separate 
collection and disposal of batteries. All lithium and rechargeable batteries must be fully discharged or protected from 
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short circuiting prior to disposal. 

19.1.15 Bluetooth module: U.S. compliance 

Contains Transmitter Module FCC ID: T9J-RN42 
 
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: 

1. This device may not cause harmful interference, and 

2. This device must accept any interference received, including interference that may cause undesired 
operation. 

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment off and on, the user 
is encouraged to try to correct the interference by one or more of the following measures: 

• Reorient or relocate the receiving antenna. 

• Increase the separation between the equipment and receiver. 

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 

• Consult the dealer or an experienced radio/ TV technician for help. 

19.1.16 Bluetooth module: Canada compliance 

Contains Transmitter Module IC: 6514A-RN42 
 
This device complies with Industry Canada’s licence-exempt RSSs. Operation is subject to the following two 
conditions: 

1. This device may not cause interference; and 

2. This device must accept any interference, including interference that may cause undesired operation of the 
device. 
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20 Carlson Boretrak End User License Agreement 

License Agreement 
 
Copyright Carlson Software All Rights Reserved 
 
CAUTION! READ THIS NOTICE BEFORE USING SOFTWARE 
 
Please read the following Software License Agreement before using the SOFTWARE. Using this SOFTWARE 
indicates that you have accepted its terms and conditions.  
 
IMPORTANT-READ CAREFULLY: This Carlson Software End-User License Agreement ("EULA") is a legal 
agreement between you (either an individual or a single entity) and Carlson Software, Inc for the software 
accompanying this EULA, which includes computer software and may include associated media, printed 
materials, and "online" or electronic documentation ("SOFTWARE PRODUCT" or "SOFTWARE"). By exercising 
your rights to use the SOFTWARE, you agree to be bound by the terms of this EULA. If you do not agree to the 
terms and conditions of this EULA, you may not use the SOFTWARE. IF YOU DO NOT AGREE TO THE TERMS 
AND CONDITIONS OF THIS EULA, DO NOT CLICK THE "ACCEPT" BUTTON, AND DO NOT INSTALL OR USE 
ANY PART OF THE SOFTWARE. 
 
Carlson Software, Inc., referred to as "LICENSOR", develops and/or licenses proprietary computer programs and 
sells use licenses for such proprietary computer programs together with or apart from accompanying copyrighted 
material and documentation and; 
 
End User desires to obtain the benefits thereof and, in return for which, is willing to abide by the obligations and 
fee agreements applicable to LICENSOR's use licenses in LICENSOR's proprietary computer programs. 
 
For good and valuable consideration, including but not limited to license grant in accordance with this Agreement 
by LICENSOR to End User's covenant regarding LICENSOR's proprietary rights, LICENSOR agrees to permit 
End User to utilize materials representing LICENSOR's product or products subject to the following terms and 
conditions: 

20.1.1 License Grant 

Subject to the terms, conditions and limitations of this EULA, LICENSOR hereby grants End User a personal, 
limited, non-exclusive, non-transferable, license to utilize the Software Product you have purchased. The license 
granted in this EULA creates no license, express or implied, to any other intellectual property of Licensor, except 
for the specific Software Product which they have lawfully purchased from LICENSOR.  
 
This EULA grants you the following rights:  
 
You may install and use one copy of the SOFTWARE PRODUCT, or any prior version for the same operating 
system, on a single computer.  
 
A license for the SOFTWARE PRODUCT may not be shared or used concurrently on different computers.  

20.1.2 Exclusive Source 

End User shall obtain all LICENSOR authorized product materials through LICENSOR or LICENSOR'S 
authorized representative and no other source. LICENSOR authorized product materials include, but are not 
limited to, manuals, license agreements and media upon which LICENSOR's proprietary computer programs are 
recorded. End User shall make no copies of any kind of any of the materials furnished by LICENSOR or 
LICENSOR's authorized representative, except as specifically authorized to do so in this EULA. End User is not 
entitled to make archival copies of those portions of LICENSOR's product(s) that are provided on a machine-
readable media. 
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20.1.3 Proprietary Rights of Licensor 

End User agrees that LICENSOR retains exclusive ownership of the trademarks and service marks represented 
by its company name and logo and all of the documentation and computer recorded data related thereto. End 
User also agrees that all techniques, algorithms, and processes contained in LICENSOR's computer program 
products or any modification or extraction thereof constitute TRADE SECRETS OF LICENSOR and will be 
safeguarded by End User, but in no event shall End User exercise less than due diligence and care in accordance 
with the laws of the country of purchase and International Law, whichever operates to best protect the interests of 
LICENSOR. End User shall not copy, reproduce, re-manufacture or in any way duplicate all or any part of 
LICENSOR products WHETHER MODIFIED OR TRANSLATED INTO ANOTHER LANGUAGE OR NOT, or in 
any documentation, or in any other material provided by LICENSOR in association with LICENSOR's computer 
program products regardless of what manner of storage and retrieval the product exists, except as specified in 
this Agreement and in accordance with the terms and conditions of this Agreement which remain in force. End 
User agrees that in the event End User breaches this EULA, End User will be liable for damages as may be 
determined by a court of competent jurisdiction.  

20.1.4 Restrictions 

End User’s rights and obligations under this EULA are nonexclusive and personal in nature, and the intellectual 
property Licensor grants to End User is subject to applicable law other than bankruptcy law. End User may not 
transfer or assign the SOFTWARE, rights under this EULA or accompanying user documentation, or any updates 
of the SOFTWARE which may be provided under this EULA, to a third party unless End User receives written 
consent from Licensor at least 30 days prior to the completion of transfer. Licensor reserves the right to deny 
transfer or assignment if, in its sole discretion, Licensor determines the transfer not to be a necessity. Whether or 
not a transfer or assignment is allowed shall be determined in Licensor’s sole discretion after taking into 
consideration certain factors to find the existence of a necessity including, but not limited to, merger or acquisition 
of an entity, complete asset acquisition, change of control, severe economic hardship, severe loss of human 
resources or significant loss in business divisions, or winding down of entity affairs.  
 
If Carlson consents to a transfer, such transfer shall be allowed only as a one-time permanent transfer of this 
EULA and Software to another end user, provided the initial End User retains no copies or previous versions of 
the Software. The transfer must include all of the Software, including all component parts, any media and printed 
materials, any upgrades, this EULA, and any associated license key. The transfer may not be an indirect transfer, 
such as a consignment, rental or lease. No corresponding Maintenance Agreement rights shall transfer with the 
SOFTWARE transfer to the subsequent end user. Prior to the transfer, the subsequent end user receiving the 
Software from the initial End User must agree to all terms of this EULA, with the added condition that no further 
transfers to third parties are permitted for any reason whatsoever, and shall agree to the terms and conditions of a 
new Maintenance Agreement with Licensor.  
 
You may not reverse engineer, decompile, or disassemble the SOFTWARE or alter the images utilized in the 
SOFTWARE and user documentation. The SOFTWARE PRODUCT is licensed as a single product. Its 
component parts may not be separated for use on more than one computer. You shall communicate to any 
individual user in your facility that they are bound by the restrictions of this license agreement may not copy or 
alter the SOFTWARE for use outside End User's facilities.  
 
Upgrades. If you purchase an upgrade of a SOFTWARE PRODUCT and you use it on different machine from one 
where upgraded SOFTWARE PRODUCT was used, use of original SOFTWARE PRODUCT must be 
discontinued and confirmed within 30 days. If such use is not discontinued, it is a material breach of this EULA 
and LICENSOR shall be entitled to all remedies available to it under this EULA, and under the laws of Kentucky, 
USA.  

20.1.5 Security Mechanisms 

Licensor and its affiliated companies take all legal steps to eliminate piracy of their software products. In this 
context, the Software Product may include a security mechanism that can detect the installation or use of illegal 
copies of the Software Product, and collect and transmit data about those illegal copies. Data collected may 
include any location and customer data created with the Software. Carlson reserves the right to utilize this 
information for both security and research and development of its security mechanisms. By using the Software 
Product, you consent to such detection and collection of data, as well as its transmission and use if an illegal copy 
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is detected. Licensor also reserves the right to use a hardware lock device, license administration software, and/or 
a license authorization key to control access to the Software. You may not take any steps to avoid or defeat the 
purpose of any such measures. Use of any Software without any required lock device or authorization key 
provided by Licensor is prohibited.  

20.1.6 Audit Rights 

End User agrees that LICENSOR has the right to require an audit (electronic or otherwise) of the LICENSOR 
Materials and the Installation thereof and access thereto. As part of any such audit, LICENSOR or its authorized 
representative will have the right, on fifteen (15) days’ prior notice to End User, to inspect End User’s records, 
systems and facilities, including machine IDs, serial numbers and related information, to verify that the use of any 
and all LICENSOR Materials is in conformance with this Agreement. End User will provide full cooperation to 
enable any such audit. If LICENSOR determines that End User’s use is not in conformity with this EULA, End 
User will obtain immediately and pay for a valid license to bring End User’s use into compliance with this EULA 
and other applicable terms and pay the reasonable costs of the audit. In addition to such payment rights, 
LICENSOR reserves the right to seek any other remedies available at law or in equity, whether under this 
Agreement or otherwise. 

20.1.7 Warranty 

THE PRODUCT IS PROVIDED "AS IS" WITH ALL FAULTS. TO THE MAXIMUM EXTENT PERMITTED BY LAW, 
LICENSOR HEREBY DISCLAIMS ALL WARRANTIES, WHETHER EXPRESS OR IMPLIED, INCLUDING 
WITHOUT LIMITATION IMPLIED WARRANTIES OF MERCHANITIBILITY, FITNESS FOR A PARTICULAR 
PURPOSE, AND WARRANTIES THAT THE PRODUCT IS FREE OF DEFECTS AND NON-INFRINGING, WITH 
REGARD TO THE SOFTWARE, AND THE ACCOMPANYING WRITTEN MATERIALS. YOU BEAR ENTIRE 
RISK AS TO SELECTING THE PRODUCT FOR YOUR PURPOSES AND AS TO THE QUALITY AND 
PERFORMANCE OF THE PRODUCT. THIS LIMITATION WILL APPLY NOTWITHSTANDING THE FAILURE OF 
ESSENTIAL PURPOSE OF ANY REMEDY. In any event, LICENSOR will not honor any warranty shown to exist 
for which inaccurate or incorrect identifying data has been provided to LICENSOR. The product(s) provided are 
intended for commercial use only and should not be utilized as the sole data source in clinical decisions as to 
levels of care.  
 
Furthermore, the Software Product may contain certain Cloud technology based features, such as messaging and 
crew view, where data can be passed freely between End Users using the Software Product. These features will 
generally be password protected, with no other built security for Software Product usage. Carlson accepts no 
responsibility for compromised data or loss due to unauthorized messaging or communication through Cloud 
technology provided in the Software Product.  

20.1.8 LIMITATION OF LIABILITY 

EXCEPT AS REQUIRED BY LAW, LICENSOR AND ITS DISTRIBUTORS, DIRECTORS, LICENSORS, 
CONTRIBUTORS AND AGENTS (COLLECTIVELY, THE "LICENSOR GROUP") WILL NOT BE LIABLE FOR 
ANY INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES ARISING OUT OF 
OR IN ANY WAY RELATING TO THIS EULA OR THE USE OF OR INABILITY TO USE THE PRODUCT, 
INCLUDING WITHOUT LIMITATION DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, LOST 
PROFITS, LOSS OF DATA, AND COMPUTER FAILURE OR MALFUNCTION, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES AND REGARDLESS OF THE THEORY (CONTRACT, TORT OR 
OTHERWISE) UPON WHICH SUCH CLAIM IS BASED. THE LICENSOR GROUP'S COLLECTIVE LIABILITY 
UNDER THIS AGREEMENT WILL NOT EXCEED THE GREATER OF $500 (FIVE HUNDRED DOLLARS) AND 
THE FEES PAID BY YOU UNDER THIS LICENSE (IF ANY).  

20.1.9 Update Policy 

LICENSOR may, from time to time, revise the performance of its product(s) and in doing so, incur NO obligation 
to furnish such revisions to any End User nor shall it warrant or guarantee that any revision to the SOFTWARE 
will perform as expected by the End User on End User’s equipment. At LICENSOR's option, LICENSOR may 
provide such revisions to the End User.  
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20.1.10 Customer Service 

Although it is the LICENSOR's customary practice to provide reasonable assistance and support in the use of its 
products to its customers, LICENSOR shall not be obligated to any End User to provide technical assistance or 
support through this Agreement and may at LICENSOR's sole election charge a fee for customer support. 

20.1.11 Termination of End User License 

If any one or more of the provisions of this Agreement is breached, the license granted by this Agreement is 
hereby terminated. In the event of such termination, all rights of the LICENSOR shall remain in force and effect. 
Any protected health information data of End User maintained on LICENSOR’S data base shall upon reasonable 
notice to End User and at the discretion of LICENSOR may be destroyed. 

20.1.12 Copyright 

The SOFTWARE (including, but not limited to, any images, photographs, animations, video, audio, music and or 
text incorporated into the SOFTWARE), and all intellectual property rights associated with it, whether exists in a 
tangible media or in an electronic image media is owned by LICENSOR and is protected by United States 
copyright laws and international treaty provisions and all other commonwealth or national laws. LICENSOR 
reserves all intellectual property rights in the Products, except for the rights expressly granted in this Agreement. 
You may not remove or alter any trademark, logo, copyright or other proprietary notice in or on the Product. This 
license does not grant you any right to use the trademarks, service marks or logos of LICENSOR or its licensors. 
You may not copy any user documentation accompanying the SOFTWARE. 

20.1.13 Injunctive Relief 

It is understood and agreed that, notwithstanding any other provision of this Agreement, LICENSOR has the 
unequivocal right to obtain timely injunctive relief to protect the proprietary rights of LICENSOR. 

20.1.14 Entire Agreement 

This EULA constitutes the entire agreement between the parties and supersedes any prior agreements. This 
EULA may only be changed by mutual written consent. 

20.1.15 End User Agreement Acknowledgment 

The End User hereby accepts all the terms and conditions of this Agreement without exception, deletion, 
alteration. End User acknowledges they are authorized to enter this agreement on behalf of any organization for 
which the license is sought. Any unauthorized use of LICENSOR products will be considered a breach of this 
Agreement, subject to liquidated damages and otherwise unlawful and wilful infringement of LICENSOR's trade 
secrets and/or proprietary products. 

20.1.16 Payment and Refund Policy 

The use of the SOFTWARE herein is deemed a commercial use and under the terms of this license agreement 
End User shall not be entitled to any refund of purchase price. End User agrees to pay all user fees promptly. 
LICENSOR is authorized by End User to suspend any further access to SOFTWARE in the event fees are not 
fully paid. End user entity shall promptly pay any and all access and use charges incurred regardless of the end 
user. End user is responsible for protecting any pass word and user identity supplied to End User. 

20.1.17 Loss/Theft/Misuse 

End user shall promptly report to LICENSOR the theft or other loss of any password and/or user identity required 
to access SOFTWARE. LICENSOR shall not be responsible for maintaining the integrity of End User data in the 
event that end user’s data base is accessed and/or altered by an unauthorized end user due to the failure of 
licensed End User to protect its password or user identity. End User shall be responsible for any costs incurred by 
LICENSOR due to the negligence or reckless disregard of End User’s failure to protect its password or user 



 

BT2 user manual - H-5911-9004-03-A   P a g e  | 143 

identity. 

20.1.18 Civil/Criminal Investigation 

End user shall fully cooperate with LICENSOR and or any person authorized by LICENSOR (including local, 
state, or federal law enforcement officials) to investigate any alleged theft, misuse or unauthorized use of 
SOFTWARE or data related thereto. 

20.1.19 U.S. Government Restricted Rights 

The SOFTWARE PRODUCT and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or 
disclosure by the Government is subject to restrictions as set forth in subparagraph (b)(1)(ii) and (c) of the Rights 
in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the 
Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable.  

20.1.20 Governing Law 

This EULA shall be governed and construed in accordance with the laws of the Commonwealth of Kentucky, 
USA.  
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